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1.0 Product Overview 

This chapter gives an overview of Active@ Boot Disk.  

1.1 About Active@ Boot Disk 
Active@ Boot Disk is a powerful set of tools that will help you in a number of 
data recovery and data security scenarios. 

Active@ Boot Disk combines a number of powerful tools that let you recover 
lost data, reset Windows passwords, make computer system backups and 
securely erase data. Active@ Boot Disk starts when you start your computer 
from a bootable CD-ROM or DVD-ROM.  

When you use Active@ Boot Disk, you gain access to the drive's data on a 
physical level, and on a logical level, bypassing the resident operating 
system. What this allows you to do is lock selected volumes for your 
exclusive use. Locking a volume is important if you want to wipe data 
residue from unoccupied space on the drive or recover data from files or 
folders. 

When you boot from the local hard drive, drive volumes cannot be locked by 
the resident system. The recover operation must have exclusive access to 
the target location. If a service or another application gains access to the 
target location, it might write over the files that you are trying to recover, 
rendering them un-recoverable. 

Here are some other functions that you can perform by booting from the CD 
or DVD: 

• Backup the system drive - If you backup the system drive with Windows 
started from the same drive, when you restore the backup, it starts as 
though you are recovering from a loss of power. The boot up starts with 
system integrity checking. If you backup the system drive with Windows 
started from an external drive, the restored system starts clean. 

• Wipe unused data from the MFT, from unused clusters, from file slack 
space (see Active@ KillDisk) - A "clean" wipe operation is not possible 
with Windows started from the same drive. If you wipe data with 
Windows started from an external drive, the wipe performs cleanly. 

• Delete files - If you delete files with Windows started from the same 
drive, Volume Shadow Copy service may still be active, keeping the 
previous version of the file or even a snapshot of the whole disk. It is 
possible that an uninvited intruder may retrieve this confidential data. If 
you delete files with Windows started from an external drive, the delete is 
permanent. 

Active@ Boot Disk contains the following products and utilities:  

• Active@ Disk Image  

• Active@ Data CD/DVD Burner 
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• Active@ Partition Recovery 

• Active@ File Recovery  

• Active@ Password Changer  

• Active@ HEX Editor 

• Active@ KillDisk  

• Active@ Partition Manager 

• Network operations utilities to help you map network drives, view 
network status, configure IP settings and Windows firewall and to help 
you connect and work with a server remotely. 

• Utilities to monitor the status of your hard disk, copy, move and delete 
files and folders and create a text file.. 

• System utilities to create, delete, format and resize partitions, manage 
system tasks, run command prompt commands, check disk integrity and 
configure the display parameters. 

• K-Meleon Web browser 

• FTP Client and Telnet Client 

• A list of documents that support Boot Disk utilities. 

1.1.1 About Active@ Boot Disk operating system 
Because the Active@ Boot Disk ISO image has been created using the 
Microsoft Windows PE (Preinstallation Environment) 2.0 operating system, 
you have access to many new Vista features using the Vista user interface.  

The bootable image contains a variety of plug-ins, drivers and other 32 bit 
applications. The best aspects from version 2.0 are the ability to create and 
use a re-writeable RAM disk, and the recognition of USB keys. 

Here are some more advantages in Windows PE 2.0: 

• You may use the new Vista-style standard dialogs, like File Open, Save 
As, and so on. 

• Security Updates: Support for SSL (Secure Socket Layer) is included.  

• PnP (Plug and Play) support: Hardware devices can be detected and 
installed while Windows PE is running. This supports any in-box PnP 
device, including removable media and mass-storage devices. This means 
that you can plug in a mass-storage device to use for data recovery or 
data backup. 

• Automatic writable RAM drive: When booting from the CD/DVD drive, 
Windows PE automatically creates a writable RAM disk (drive X:) and 
allocates 32 MB of the RAM disk for general-purpose storage. By using 
compressed NTFS, the 32 MB is addressable up to 60 MB. This drive 
space may be used to recover files or folders. 
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Note  After the Windows operating system and Active@ Boot Disk have started, 
the boot CD/DVD can be removed from the drive. A new CD/DVD can be 
inserted into the drive and you can read from it or burn data to it. 

 

1.2 Requirements for Using Active@ Boot Disk 
To use Active@ Boot Disk, you must have the following: 

• Pentium II processor or higher 

• 300MB or more RAM 

• A CD/DVD drive or a USB mass storage device to boot from 

In addition to the above, you must be able to turn on power to the machine 
and you must have access to the system board BIOS setup. 

1.2.1 How the system RAM is used 
The ISO for Active@ Boot Disk was created from Windows PE (Preinstallation 
Environment), a lightweight version of Windows Vista. 

When booting from the CD/DVD drive or from a USB storage device, 
Windows PE creates a writable RAM disk (X:) and places itself on this drive 
for loading. While Windows Vista is booting up, it loads itself into RAM. After 
Windows has started, the boot CD/DVD may be removed from the drive or 
the USB flash card may be removed from the USB port. Starting with 300MB 
of RAM, all that is left is about 60MB of writable space to work with. 

 

1.3 Downloading Active@ Boot Disk 
You must perform these operations on a separate computer that has a 
healthy hard drive and access to the Internet. 

To download Active@ Boot Disk: 

1. On the Internet, navigate to http://www.boot-disk.com. 

2. To download Active@ Boot Disk (Win Edition), click the Buy Now! link 
and follow the procedure for paying. 

3. To download the 10-day Demo version, click the Download link. 

4. You may save the file to a folder on your machine or you may run the 
file directly from the Internet folder. 

5. The install wizard steps you through pages to agree to the terms of the 
license and determine the destination folder. 
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1.3.1 Active@ Boot Disk Creator 

6. In the Select Components page, for assistance with writing Active@ 
Boot Disk to a bootable CD, DVD or USB mass storage device, select the 
Active@ Boot Disk Creator check box. 

7. After Active@ Boot Disk has been successfully installed, select the Run 
Active@ Boot Disk Creator check box and click Finish.  

Continue with the next section. 

 

1.3.1 Active@ Boot Disk Creator 
Active@ Boot Disk Creator helps you prepare a bootable CD, DVD or USB 
mass storage device that you may use to start a machine with a damaged 
hard drive and recover data, recover partitions, create a disk image or repair 
security access issues. 

To prepare a bootable device for Windows: 

1. In the Active@ Boot Disk Creator main page, click Boot Disk Win 
Edition. The Boot Disk Win Edition page appears. 

2. To prepare a bootable CD or DVD: 

a. Click Win CD/DVD Boot Disk. The Win CD/DVD Boot Disk page 
appears. 

b. To write the Boot Disk ISO file to a different folder, click Browse 
and navigate to the folder. 

c. Insert a blank or re-writable CD or DVD into the disk writer. 

d. Click Create!. A progress bar appears. 

3. After the ISO has been created, you must write it to a bootable CD or 
DVD. 

If you have a disk burning utility that you prefer to use, use it to burn 
the ISO to a disk. Section 1.3.2 has instructions for some other utilities. 

4. If you do not have a disk burning utility, you may choose to use 
Windows Burning Engine.  

To upgrade the Windows Burning Engine: 

a. Open a connection to the Internet. 

b. From the Windows Start button, choose All Programs > Active@ 
Boot Disk > Windows Burning Engine Update from 
Microsoft.  A new session of your default web browser opens to 
http://www.ntfs.com/burning_engine_update.htm.  

c. Download the file from the ntfs site and install it on your computer. 

5. If you choose not to use Windows Burning Engine, you may use 
Active@ ISO Burner utility. Continue with the steps below. 

1.3 Downloading Active@ Boot Disk  7 



a. In the Active@ ISO Burner main page, in the Step 1 area, the path 
to the ISO appears. To change this path and use a different ISO, 
click the ellipsis button (…) and navigate to the ISO. 

b. In the Step 2 area, the disk burning device name appears. To use a 
different disk burning device, select it from the drop-down list. 

c. To choose a different burning speed, select it from the speed drop-
down list. 

d. To change burning settings, click the Settings link and change 
settings on the dialog box. 

e. Click BURN ISO!. A progress bar appears. 

f. After the CD or DVD has been finalized, the disk ejects and a 
success message box appears. Click OK. 

g. To burn another CD or DVD, insert a blank disk and click BURN 
MORE!.  

6. To prepare a bootable USB mass storage device: 

a. Insert a blank USB mass storage device into any USB port. 

b. Click Win Bootable USB Device. The Win Bootable USB Device 
page appears.  

c. To write the Boot Disk ISO file to a different folder, click Browse 
and navigate to the folder. 

d. Click Create!. A progress bar appears. 

e. After the ISO has been created and copied onto the USB device, you 
must use Safely Remove Hardware to stop and unplug the 
device. 

Note  If you receive an error message when using Active@ ISO Burner, you 
may use other CD/DVD burning utilities to burn the CD or DVD. 

 

1.3.2 Burn the ISO to a bootable CD using other utilities 
If you have Roxio EasyCD Creator or Ahead Software Nero - Burning ROM 
installed, you may use either one of them to burn the ISO to a bootable CD 
or DVD. 

 

Nero – Burning ROM (Ahead Software) 

For more information about this program, visit the Ahead Software Web site 
at: http://www.ahead.de. 

To burn the ISO to a CD using Nero - Burning ROM:  

1. Insert a blank CD in your CD-RW drive.  

2. Start Nero - Burning ROM.  
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1.3.2 Burn the ISO to a bootable CD using other utilities 

3. Follow the wizard steps to burn a Disk Image.  

4. In the Open dialog box, locate the Active@ Boot Disk ISO file, and then 
click Open.  

5. In the wizard, click Burn.  

The ISO image is burned to the CD 

 

EasyCD Creator (Roxio)  

When the program is installed, it is automatically associated with the ISO file 
extension in Windows Explorer. For more information about this program, 
visit the Roxio Web site at: http://www.roxio.com. 

To burn the ISO to a CD using EasyCD Creator:  

1. Insert a blank CD in your CD-RW drive.  

2. Start Windows Explorer and navigate to the Active@ Boot Disk ISO file.  

3. Right-click the file name, and then click Open. The EasyCD application 
starts.  

4. In the Write Method section of the CD Creation Setup dialog box, click 
Disk at Once for optimum recording performance.  

5. Click OK.  

The ISO image is burned to the CD. 

 

1.4 BootDisk_Drivers and BootDisk_Scripts 
You can automate some functions using Active@ Boot Disk.  

While Active@ Boot Disk is starting, you may install drivers and run scripts 
that can reduce the amount of time it takes to perform maintenance 
functions on your data storage system. 

If you know that your hard drive has damaged drivers, or if you have older 
or uncommon RAID type or SCSI type drivers, you may create a folder 
named BootDisk_Drivers on the root of any logical drive and load drivers 
along with their configuration files into it. Active@ Boot Disk will detect these 
drivers and install them automatically during the boot process.  

While Active@ Boot Disk is loading (described in the next section, below), 
the utility searches for the BootDisk_Drivers folder in the root of all 
devices. That includes the floppy drive, a USB device, a working hard drive, 
and so on. 

If Active@ Boot Disk finds .INF files inside a folder named 
BootDisk_Drivers, it tries to load them along with all other files required 
by the drivers.  

1.4 BootDisk_Drivers and BootDisk_Scripts  9 



Whether or not the utility loads drivers, Active@ Boot Disk proceeds to 
search for a folder named BootDisk_Scripts – again in the root of any 
logical drive. Active@ Boot Disk will run any CMD files, assuming that they 
are scripts. 

 

 

1.5 Booting from a CD, DVD or USB Device 
You can start your computer and perform data recovery and other functions 
by starting from a bootable CD, DVD or USB device. 

To start your computer with the Active@ Boot Disk CD, DVD or USB device, 
you must first download the ISO file and burn it to the medium. 

Before you use Active@ Boot Disk, you must purchase it and obtain a 
registration key.  

Note  For instructions on setting boot sequence priority in the system BIOS, see 
Chapter 3.0 About Boot Priority. 

 

To boot from the Active@ Boot Disk device: 

1. To boot from a CD or DVD, put the bootable Active@ Boot Disk CD or 
DVD disk into the player. 

2. To boot from a USB device, plug the bootable Active@ Boot Disk USB 
device into a USB port. 

3. Start the power on the machine. In a DOS screen, the following message 
appears: 

Press any key to start Active@ Boot Disk... 

4. Press a key on the keyboard. The screen changes and appears to be 
loading the kernel. 
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1.3.2 Burn the ISO to a bootable CD using other utilities 

 
5. The screen goes dark for a length of time. Wait for the console to load.  

6. The Active@ Boot Disk Console appears.  

1.5 Booting from a CD, DVD or USB Device  11 



 
 

The console detects and loads hardware drivers and starts the network. 
This may take a long time and the screen may flash to black and back to 
the console. 

The console runs scripts and checks for errors and missing information. 

7. The Active@ Boot Disk shell appears.  

 

12  Active@ Boot Disk User Guide 



1.3.2 Burn the ISO to a bootable CD using other utilities 
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You are ready to use the utilities in Active@ Boot Disk. 

After you start the computer this way, you have full exclusive access to the 
system drive. With this kind of access, you can perform tasks that are not 
possible when Windows has been started from the hard drive.  

The only other way to get this type of exclusive access to your hard drive 
would be to physically remove your hard drive and install it on another 
computer. After installing the hard drive, you would have to boot up from 
the second computer's local drive and access the files on your original hard 
drive. 

Note  You cannot save registration information to a file on a hard drive with 
damaged partitions. 

Note  If you have successfully booted from the CD, DVD or USB device and you 
do not see your C: drive because it is a Stripe Array (Raid-0) or if you are 
using an older or non-standard controller, see instructions in 2.7 Load 
Drivers. 



2.0 Navigating the Active@ Boot Disk Shell 

In the shell, select a category from the list. Links to the utilities in that 
category appear in the right panel. 

 

Active@ Boot Disk provides utilities to perform the following: 

• Data Backup – Backup or restore physical and logical hard drives, 
including folders, data files and installed applications. You may use an 
ISO disk image or you may burn files to a CD or DVD. Protect your 
valuable data by regularly making backups. 

• Data Recovery – Recover data from deleted or damaged partitions on 
attached or external drives, portable drives and memory cards. Recover 
data from damaged or deleted files or folders. Reset password and user 
accounts on your system. View and edit disk sector content in raw 
format. 

• Data Security – Securely erase data from hard drives in a way that it is 
impossible to restore the data. Wipe data from unused clusters on a 
regular basis to make your drive's deleted or temporary data unavailable 
to intruders. 

• Network – Network operations utilities to map network drives, view 
network status, renew your computer IP address or connect to a remote 
desktop. 

• Utilities – Monitor the physical status of your hard drives, create delete 
and format drive partitions, copy move and delete files and folders and 
edit registry parameters. Also make notes about actions that you have 
done or need to do. 

• System – Run system utilities like Windows Task Manager, Partition 
Manager and Check Disk. Run commands in a DOS environment. Also, 
change the display resolution and color mode. 

• Internet – Run K-Meleon web browser to explore the Internet, download 
files from an FTP site or use Telnet client to connect to a Telnet server. 

• Documentation – Documents included with Active@ Boot Disk. 

After you have successfully started Active@ Boot Disk, click Utilities > 
Explore My Computer. The ExplorerXP utility appears. You should see all the 
physical and logical devices associated with your computer along with the 
ISO disk image named Boot (X:). 

 

Note  When you exit the Active@ Boot Disk shell, you have the option to shut 
down your computer, restart it or cancel the exit routine. 



2.1.1 Active@ Disk Image help 

 

2.1 Data Backup Utilities 
Active@ Disk Image is a Windows-based solution that allows you to create 
an exact image of the data stored in selected partitions of a hard disk or an 
image of the entire hard disk. You can protect your valuable data by 
regularly making a disk image and keeping it in a safe place. If you have 
trouble with data corruption, or if you want to refer to an archived version of 
a file, you can easily restore the data. 

Active@ Data CD/DVD Burner is a burning tool used to write/burn files 
and folders onto CD-R, DVD-R, DVD+R, CD-RW, DVD-RW, and DVD+RW. 

Note  For instructions and support on how to run Active@ Disk Image and 
Active@ Disk Image Explorer, open the PDF user guide from the 
Documentation page. 

2.1.1 Active@ Disk Image help 
Active@ Disk Image is a Windows-based solution that allows you to create 
an exact image of the data stored in selected partitions of a hard disk or an 
image of the entire hard disk. You can protect your valuable data by 
regularly making a disk image and keeping it in a safe place. If you have 
trouble with data corruption, or if you want to refer to an archived version of 
a file, you can easily restore the data. 

The application provides many tools around backing up data on your hard 
disk: 

•  Disk to Image - Opens the Disk to Image Wizard. Helps you to create a 
regular type disk image archive of an entire disk or of selected partitions 
in the system.  

•  Image to Disk - Opens the Image to Disk Wizard. Helps you to restore 
data from a disk image archive.  

•  Explore Image - Opens Active@ Disk Image Explorer. Helps you to 
browse through folders and files in a disk image as though it was a hard 
drive. You may select folders or individual files and restore them.  

•  Verify Image - Opens the Verify Image Wizard. Helps you check the 
integrity of a disk image archive file.  

•  Create Raw Image - Opens the Create Raw Image Wizard. Helps you 
create a raw type disk image of only one partition or the entire disk.  

•  Clone Disk - Opens the Clone Disk Wizard. Helps you to transfer a sector-
by-sector copy from one disk (partition) to another.   

• Partition Manager – A tool that helps you create, delete, format or show 
properties of partitions on all devices in your system. 
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This guide describes only the Disk to Image tool. For a description of the 
other tools, see the Active@ Disk Image User’s Guide document in the 
Documentation  tab of the Active@ Boot Disk shell. 

2.1.1.1 Creating a Disk or Partition Image 
The Disk to Image Wizard steps you through the process of creating a disk 
image for a whole disk or a number of partitions. 

To create a disk or partition image: 

1. To open Active@ Disk Image, in the Active@ Boot Disk shell, click Data 
Backup > Active@ Disk Image. 

2. To open the Disk to Image Wizard, from the Tools menu, choose Disk 
to Image.  

3. Click Next. The Select Disks and Partitions page appears. 

4. Select a check box next to a disk or partition if you want to include that 
disk or partition in the disk image. At the bottom of the list a total size 
for the selected partitions is displayed. 

5. Click Next. The Indicate Backup Location page appears. 

6. Do the following: 

• If a CD/DVD burner is available, select the CD/DVD radio button, select 
a device from the Device drop-down list and type a descriptive disk 
image name into the Backup name field.  

• To save the disk image to a hard disk, select the Local or network file 
radio button, type a descriptive disk image name into the Backup 
name field and type the path or click Browse... and navigate to the 
location where you want to save the disk image. 

7. Click Next. The Image Options page appears. 

8. Do the following: 

• To set the compression speed, select one of three radio buttons:  

• None give you fast results and a larger file size.  
• Normal (recommended) is a compromise between a smaller file 

size and a faster operation speed.  
• High provides the smallest file size and takes the longest time to 

complete. 

• To try saving the disk image to a single file, in the Image Splitting 
area, select the Automatic (try single file) radio button. If the 
system runs out of free disk space on the disk where you are saving 
the backup—or if you are storing an image file on disk with a FAT file 
system—Active@ Disk Image automatically splits the archive into 
multiple files and prompts you for the path to write the next file. 
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2.1.2 Active@ Data CD/DVD Burner help 

• To manually indicate how to split the disk image, in the Image Splitting 
area, select the Fixed size (MB) radio button and type a file size in 
megabytes or choose a size from the drop-down list. 

• To protect sensitive data on a disk image, in Password, type a 
password (maximum 16 characters) and type the same password in 
Confirm.  

• Optionally, type a short description of your disk image (maximum 
1,024 characters) into the Image description text box.  

9. Click Next. The Confirm Operation Details page appears. 

10. Do the following: 

• Review the details in the summary.  

• To write a log of events into a text file, select the Write text log to 
check box and type the path to the text file or click Browse… and 
navigate to the location where you want to save the text file. 

11. Click Next. The Progress Status page appears. 

12. You may watch the progress of the operation. 

13. To stop the operation at any time, click Cancel. 

 

2.1.2 Active@ Data CD/DVD Burner help 
To run Active@ Data CD/DVD Burner: 

1. From the Active@ Boot Disk shell, click Data Backup > Active@ Data 
CD/DVD Burner. The Active@ Data CD/DVD Burner dialog box 
appears. 

2. Place a writable CD/DVD in the drive. 

3. To add a folder, in the Base field, click Browse. Navigate to a base 
folder to burn to the CD/DVD. Select it and click Open. The name of the 
selected folder appears. 

4. To add a file, in the Root list, click Add File. Navigate to a file to burn to 
the CD/DVD. Select it and click Open. The file name appears in the list. 

5. To add a folder, in the Root list click Add Folder. Navigate to a folder to 
burn to the CD/DVD. Select it and click Open. The folder name appears 
in the list. 

6. To remove an item from the Root list, select it and click Delete. 

7. To label the CD/DVD, type a descriptive label in Disc Label. 

8. To burn files and folders to the CD/DVD and keep the original path 
hierarchy, in File and Folder Path, click the Keep Full Path radio 
button.  
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9. To burn all files and folders to the root of the CD/DVD, click the Normal 
(No Path) radio button. 

10. Select a drive and a write speed from the Burner drop-down list. 

11. To change write settings: 

a. Click Settings. The Active@ Data CD/DVD Burner Settings 
dialog box appears. 

b. Change the settings to suit your writing needs. 

c. Click OK. 

12. Click BURN! 

Files are written to the CD/DVD. 

2.2 Data Recovery Utilities 
This section provides help with the following:  

• 2.2.1 Data Recovery Tips – General tips around data recovery. 

• 2.2.2 Active@ Partition Recovery - Recover lost partitions. This 
means that you can recover deleted or damaged partitions located on 
data volumes (D:, E:, and so on), attached hard drives, as well as on the 
external USB drives and Memory Cards (SunDisk, MemoryStick, 
CompactFlash, etc.). On a system partition, BOOT.INI is corrected 
automatically (if needed) to repair an un-bootable system. As well, 
damaged Volume Boot Sectors are corrected to maintain integrity of the 
partition. This utility also enables you to fix a damaged MBR and to delete 
invalid partitions.  

• 2.2.3 Active@ File Recovery - Recover lost or deleted files. You can 
recover data from a hard drive that has been formatted or from a hard 
drive with lost partitions. You can also recover files that have been 
damaged, destroyed by a virus or if the file directory has been destroyed. 
This utility will even recover files after they have been emptied from the 
Recycle Bin. The utility scans computer hard drives in minutes and 
displays all files that can be recovered. 

• 2.2.4 Active@ Password Changer - Use a simple interface to recover 
from forgotten or damaged user passwords. This utility supports multiple 
hard disk drives. If multiple operating systems were installed on one 
volume, this utility detects several SAM (Security Account Manager) 
databases and lets you pick the right SAM before starting the password 
recovery process. To reset account attributes, Active@ Password Changer 
displays a list of all local users. You choose each local user from the list to 
reset the password. 

• 2.2.5 Active@ HEX Editor - Edit a disk’s raw sector data to analyze and 
repair the MBR and other important files. 
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2.2.1 Data Recovery Tips 

 

2.2.1 Data Recovery Tips 
DO NOT WRITE ANYTHING ONTO THE DRIVE THAT CONTAINS YOUR 
IMPORTANT DELETED DATA!  

When you install software, you write data onto the disk. This can destroy 
your deleted data. If you have only one logical drive, physically remove the 
hard drive from the computer and install it as a second logical drive on 
another computer where data recovery may be possible. 

DO NOT SAVE RECOVERED DATA ONTO THE SAME DRIVE THAT CONTAINS 
THE LOST OR DAMAGED DATA!  

When saving recovered data, you are writing records to the file table. If you 
write these records to the same drive that contains the damaged data, you 
are destroying the file table records that you are trying to recover. At the 
same time, you may be destroying the file table records for other deleted 
entries. It is best to save recovered data onto another logical, removable or 
network drive. 

CREATE A RAW DISK IMAGE IF YOU HAVE AN EXTRA HARD DRIVE, OR 
OTHER LOGICAL DRIVES THAT ARE BIG ENOUGH!  

A Raw Disk Image is a single file that stores all the data from your logical 
drive or physical device as a mirror image. Having a Raw Disk Image can be 
useful when you want to back up the contents of the whole drive, and 
restore it or work with it later. Before you start recovering deleted files, it 
may be a good idea to create a Raw Disk Image for the one drive, if you 
have enough space on another drive. If you do something wrong while 
recovering the files (for example, recovering them onto the same drive and 
destroying the data), you will be able to recover these deleted files and 
folders from the Raw Disk Image that you have wisely created. 

 

2.2.2 Active@ Partition Recovery Help 
Active@ Partition Recovery is a data recovery utility that you can use to: 

• 2.2.2.1 Find and recover deleted partitions and logical drives 

• 2.2.2.2 Create a Drive Image for backup purposes  

• 2.2.2.3 Fix or create a typical MBR (Master Boot Record)   

 

For any computer to boot properly, the following conditions must apply:  

• The MBR (Master Boot Record) exists and is not damaged  

• The Partition Table exists and contains at least one active partition  
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If these conditions exist, the executable code in the MBR selects an active 
partition and passes control to it so that it can start loading the system files 
(COMMAND.COM, NTLDR, ... ).  

If these files are missing or corrupted then the operating system will be 
unbootable.  

 

2.2.2.1 Find and recover deleted partitions and logical drives 
To find and recover deleted partitions and logical drives: 

1. From the Active@ Boot Disk shell, click Data Recovery > Active@ 
Partition Recovery. The Active@ Partition Recovery workspace 
appears with all available devices listed in a tree view under Local 
System Devices. 

2. To scan an unallocated space, select it. Known details of the selected 
item are displayed in the right pane. 

3. To scan the unallocated space in basic mode, do the following: 

a. Click Quick Scan. The status bar displays the progress of the scan.  

b. After the scan is complete, a list of all allocated and unallocated 
partitions appears in the Local System Devices list. 

4. If you cannot see a logical drive, to process the whole surface of a disk, 
select it and click Super Scan. The Super Scan Options dialog box 
appears. Do the following: 

a. From the Scan What drop-down list, choose the area that you want 
to scan. 

b. To restrict the scan to a small number of sectors, indicate the From 
sector and the number of sectors to scan. 

c. Select the check box next to each type of partition that you want to 
scan. 

d. Click Start. The status bar displays the progress of the scan. 

e. After the scan is complete, a new folder named SuperScan appears 
in the Local System Devices list.  

5. To display a smaller set of SuperScan results, do the following: 

a. Right-click the SuperScan device node folder.  

b. From the context menu choose Filter... The Filter Found 
Partitions dialog box appears.  

c. To select the types of file systems data that are displayed, in the 
Display File Systems area, clear the check box beside the types 
that you do not want to display.  

d. To display only those partitions within a specified size limit, in the 
Partition Size area, indicate the minimum and maximum size of 
partitions in Megabytes.  
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e. To use basic filtering parameters, in the Filter Type area, click Use 
Basic Filtering.  

f. To select displayed partitions based on partition status, in the Basic 
Filtering [Partition Status] area, clear the check box next to each 
partition status number that you do not want to display. 

g. To use advanced filtering parameters, in the Filter Type area, click 
Use Advanced Filtering.  

h. To restrict displayed results for NTFS-specific parameters, in the 
Advanced Filtering [NTFS specific] area, select the check box 
beside all the types of data that you want to display.  

i. To restrict displayed results for FAT-specific parameters, in the 
Advanced Filtering [FAT specific] area, select the check box 
beside all the types of data that you want to display.  

j. Click Filter. The right panel displays the filtered results. 

6. You may manage other aspects of SuperScan results: 

a. To resume a stopped SuperScan, right-click the folder and choose 
Resume from the context menu. SuperScan resumes. 

b. To save scan results, right-click the SuperScan folder and choose 
Save Scan Results. Similarly, you may open the saved scan results 
at a different time. 

c. To delete a SuperScan folder, right-click the folder and choose 
Delete. 

d. To display detailed properties of a SuperScan folder, right-click the 
folder and choose Properties. 

7. To recover deleted or damaged partition select it and click Recover. 
The Active@ Partition Recovery parameters dialog box appears. To 
specify recovery options, do the following: 

a. To ensure that the Windows operating system assigns the correct 
letter to the disk, select a disk letter from the Assign Disk Letter 
drop-down list. 

b. To set the recovered partition as active and allow the system to boot 
from it, select the Set Partition Active check box. 

c. The recovery process checks the boot sector and fixes it if it is 
damaged. Select Automatic or Manual, depending on how you 
want to do this. 

d. If the disk has an extended partition, select the Create Extended 
Partition First check box and/or use ALL Unallocated area 
check box. If these areas are not available, these check boxes will 
be disabled. 

e. To save a copy of the partitioning information before recovering, 
select the Backup Current Partitioning Info check box and 
indicate the file name to store the backup. 

f. Click Recover. 
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The partition is recovered to the new path. 

 

2.2.2.2 Creating a Raw Disk Image 
A Raw Disk Image is a mirror copy of your entire logical drive or physical 
device stored as set of files. It may be a good idea to create a Raw Disk 
Image for a drive containing deleted files that you want to recover, if you 
have enough space on another drive. If you do something wrong while 
attempting to recover a partition, you will be able to recover these deleted 
files and folders from the Raw Disk Image of that partition.  

A Raw Disk Image consists of a configuration file (with an extension .DIM) 
and set of files having extensions .000, .001, .002 ... Each file has a size of 
2Gb.  

 

Important  Do not save a Raw Disk Image back onto the disk that you are 
backing up. The target location to save the Raw Disk Image must always 
be another drive. 

To create a Raw Disk Image:  

1. In the Active@ Partition Recovery workspace, select a logical drive or a 
physical device.  

2. Click Image. The Create Disk Image dialog box appears. 

3. In the Save In drop-down list, select another physical device or another 
logical drive.  

4. Browse to the folder where you want to save the Disk Image.  

5. In File Name, give the Disk Image file a descriptive name. 

6. Click Save. A progress bar appears. 

Watch the progress and wait while drive's contents are copied to the new 
location. You may cancel the process of image creation anytime by clicking 
Stop.  

 

2.2.2.3 Fixing or creating the MBR 
The MBR (Master Boot Record) is created when you generate the first 
partition on a hard disk. It is probably the most important data structure on 
the disk. The location is always track (cylinder) 0, side (head) 0, and sector 
1. The MBR contains the partition table for the disk and a small amount of 
executable code. On x86-based computers, the executable code examines 
the Partition Table, and identifies the system partition. The MBR then finds 
the system partition's starting location on the disk, and loads a copy of its 
Partition Boot Sector into memory. The MBR then transfers execution to 
executable code in the Partition Boot Sector.  
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To fix or create a typical MBR: 

1. In the Active@ Partition Recovery workspace, in the Local System 
Devices list, select a disk. 

2. From the Tools menu, choose Fix MBR (Create Typical MBR). A 
Warning message appears.  

3. Click Yes.  

The MBR is fixed. 

 

2.2.3 Active@ File Recovery Help 
Active@ File Recovery is a data recovery utility that you can use to restore 
accidentally deleted files and folders located on existing drives, and even on 
deleted or damaged partitions. 

It is best to save recovered data onto another logical, removable, network or 
floppy drive. Make sure that you have access to another physical or logical 
drive before attempting to recover a file.  

 

To run Active@ File Recovery: 

1. From the Active@ Boot Disk shell, click Data Recovery > Active@ 
File Recovery. The Active@ File Recovery workspace appears with 
all available devices listed in a tree view under Local System Devices. 

2. To scan a logical drive, select it. A message in the right pane reads Disk 
not scanned yet... 

3. To scan the drive in basic mode, do the following: 

a. Click Quick Scan. The status bar displays the progress of the scan.  

b. After the scan is complete, a list of all folders and files appears in 
the right pane. 

4. If you cannot locate or find your deleted files and folders, to process the 
whole surface of a disk, select it and click SuperScan. The SuperScan 
Options dialog box appears. Do the following: 

a. From the Scan What drop-down list, choose the drive that you 
want to scan. 

b. To restrict the scan to a small number of sectors, indicate the From 
sector and the number of sectors to scan. 

c. Select the check box next to each type of partition that you want to 
search for deleted files and folders. 

d. To use utility tools to re-build image files (BMP, JPG, DOC, ZIP, etc.) 
from partial data, select options in File types to be recognized based 
on signatures area. 
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e. Click Start. The status bar displays the progress of the scan. 

f. After the scan is complete, a list of detected partitions appears in the 
right pane. You may search through these partitions. 

g. If you chose to re-build image files, a folder named Files Recognized 
by Signatures appears. You may search through the contents of this 
folder. 

5. After you have scanned a drive, to search for deleted or damaged 
folders or files: 

a. To search manually, browse through the contents of each folder in 
the Local System Devices list.  

b. To use the search tool, click Search. The Advanced Search dialog 
box appears. 

c. In the Find What field, enter all or part of a file or folder name. You 
may use wildcard characters to locate all files or folders that include 
that part in a name. 

d. In the Find Where drop-down list, select a device or a partition to 
search. 

e. In the File Type drop-down list, select the type of file or folder to 
search for. 

f. In the next three check boxes, you may choose to: 

• Include deleted files and folders - Select this check box to 
search through files and folders marked as deleted. If you know 
that the file or folder you are searching for has not been deleted, 
that is - if the file or folder is damaged and still exists in the file 
table - clear this check box. 

• Include non-deleted files and folders - Select this check box 
to search through existing files and folders. If you know that you 
are searching for a deleted file or folder, clear this check box. 

• Case insensitive search - File Recovery will search for the Find 
What file or folder name without regard to upper or lower case 
letters. To search for a file or folder using only the upper or lower 
case letters specified in Find What, clear this check box. 

6. To search for files or folders based on a specified date range, select any 
combination of check boxes for Created, Modified or Accessed 
(Deleted) and indicate the date range. 

7. To search for files or folders based on the size of the file, select the Size 
check box and indicate a size range.  

8. To start the search, click Find. The status bar displays the progress of 
the search. 

9. After the search is complete, a new folder named Search appears in the 
Local System Devices list.  

10. Select a file or folder that you want to restore. 
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11. Click Recover. The Recovery Options dialog box appears. Do the 
following: 

a. In the Name field, revise the file name. 

b. In the Recover To field, enter a path to a drive other than the drive 
where you found this file or folder. You may also browse to another 
drive. 

c. Click Recover.  
The file or folder is recovered to the new path. 

 

Note  A device scan or a search may take a long time. To stop a device scan or 
a search, click Stop at any time. 

2.2.4 Active@ Password Changer Help 
You can use Active@ Password Changer to recover your passwords and user 
account attributes in a Windows Vista environment.  

Active@ Password Changer is designed for resetting the local administrator 
password on Windows Vista systems in case the administrator's password is 
forgotten or lost. You do not need to re-install and re-configure the 
operating system.  

This utility supports multiple hard disk drives, detects several SAM databases 
(if multiple operating systems were installed on one volume) and provides 
the opportunity to pick the right SAM before starting the password recovery 
process. It also displays a list of all local users.  

Other Windows login security restrictions can be reset, for example: 

• 'Account is disabled' 

• 'Password never expires' 

• 'Account is locked out' 

• 'User Must Change Password at Next Logon' 

• 'Logon Hours' 

With Active@ Password Changer you can log in as a particular user with a 
blank password. 

 

To use Active@ Password Changer: 

1. From the Active@ Boot Disk shell, click Data Recovery > Active@ 
Password Changer. The Active@ Password Changer dialog box 
appears. 

2. To change passwords on the current drive, click Choose the Logical 
Drive. 
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3. To scan the disk and detect multiple operating systems, do the 
following: 

a. Click Search for MS SAM Database(s). 

b. Click Next. The progress bar indicates the status of scanning. A list 
of SAM hives appears.  

c. Select a database from the list. 

4. Click Next. The list of users appears. 

5. Select a user from the list and click Next. The parameters for the 
selected user appear. 

6. Select parameter check boxes to create the situation that you want. 

7. Click Save. A confirmation dialog box appears. 

8. Click Yes. An information message indicates that the changes have been 
made. 

9. Click OK. 

10. For each user that you want to change, repeat steps 5 through 9. 

 

2.2.5  Active@ HEX Editor Help 
Active@ HEX Editor is a utility to help you edit a disk's raw sector data. The 
editor displays information in binary and text modes at the same time. You 
can use this view to analyze the contents of data storage structure elements 
such as hard disks and partitions. 

The Open Disk dialog box displays a list of available storage devices and a 
list of logical drives.  

The Data Inspector displays whatever is currently under the cursor. It does 
so in ten different formats. This may help you interpret data as displayed in 
HEX Editor. If you choose to view the Data Inspector, the window always 
appears at the top level when you are using Active@ HEX Editor.  

A destructive virus may damage the MBR (Master Boot Record) and make it 
impossible to start the computer from the hard disk. When you start the 
computer, the code in the MBR executes before the operating system is 
started. If the MBR is corrupted, the operating system cannot start. The 
location of the MBR is always track (cylinder) 0, side (head) 0, and sector 1. 
You may use Active@ HEX Editor to repair a damaged MBR. 

 

This section contains help with the following: 

• 2.2.5.1 Starting Active@ HEX Editor 

• 2.2.5.2 Setting Default Options for the Utility 

• 2.2.5.3 Navigating to Key Sectors 
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• 2.2.5.4 Editing Tools 

• 2.2.5.5 Changing the Workspace View 

 

2.2.5.1 Starting Active@ HEX Editor 
To start Active@ HEX Editor:  

1. From the Active@ Boot Disk shell, click Data Recovery > Active@ HEX 
Editor. The Open Disk dialog box appears. 

2. Click a device or a logical drive to select it. 

3. Click Open. The Active@ HEX Editor workspace appears. 

4. To browse through the content of the open item: 

a. Click either the hexadecimal area or the text area to focus on it.   

b. Use the scroll bar, keyboard arrows or the mouse wheel.  

5. To toggle the focus between hexadecimal and text panes, press TAB.  

 

2.2.5.2 Setting preferences for the utility 
When you start Active@ HEX Editor, the default view shows the Info Pane on 
the left and the editing pane on the right, with a Status Pane across the 
bottom. You may change the default configuration of the workspace so that 
it opens with your custom settings each time. 

To change Active@ HEX Editor default options: 

1. In Active@ HEX Editor, click Preferences. The Preferences dialog box 
appears. 

2. You may show or hide the Status Pane at the bottom of the workspace: 

• To hide the Status Pane, clear the Show Status pane check box. 

• To show the Status Pane, select the Show Status pane check box. 

3. You may show or hide the Info Pane on the left of the workspace: 

• To hide the Info pane, clear the Show Info pane check box. 

• To show the Info Pane, select the Show Info pane check box. 

4. To change the default size of the font in the editing pane, select a size 
from the Font size drop-down list. 

5. To show only selected values in the Data Inspector:  

• Select the check box next to each value that you want to display. 

• Clear the check box next to values that you do not want to display. 
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2.2.5.3 Changing the workspace view 
You may change the workspace configuration at any time while you are 
working in Active@ HEX Editor.  

To change the configuration of the workspace: 

1. To toggle the Info Pane between view and hide, from the View menu, 
select Info Pane. 

2. To toggle the Status Pane between view and hide, from the View 
menu, select Status Pane. 

3. To toggle the Data Inspector between view and hide, from the View 
menu, select Show Data Inspector. 

4. To change the size of the font in the editing pane, from the View menu, 
choose Text Size and select a different size. 

5. To toggle the display of the current address offset between hexadecimal 
and decimal, from the View menu, choose Hexadecimal Offset. 

 

2.2.5.4 Navigating to Key Sectors 
To navigate to key sectors on the open item: 

1. To open a different device or logical drive: 

a. Click Open Disk. The Open Disk dialog box appears. 

b. Click a device or a logical drive to select it. Click Open.  

c. The Active@ HEX Editor workspace appears. 

2. To jump to a named offset: 

a. From the Navigate menu, choose Jump to... The Goto offset 
dialog box appears. 

b. To jump to a named sector, in the Sector field, type the sector 
number. 

c. To jump to a place defined by disk geometry, click the Disk 
geometry radio button and type the cylinder, head and sector 
numbers in the appropriate fields. 

d. Click Go. The sector appears in the editing panel. 

3. To jump to the boot sector, from the Navigate menu, choose Boot 
Sector (0). The boot sector appears. 

4. To jump to the partition table, from the Navigate menu, choose 
Partition Table. The partition table sector appears in the editing panel. 

5. To edit the partition table template: 

a. From the Navigate menu, choose Partition Table (Template). 
The Partition Table dialog box appears. The Signature (55 AA) 
marks the end of the Partition Table.  
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b. Review and modify the settings for partition table entries 1, 2, 3 and 
4. 

c. To restore all default settings, click Set Defaults. 

d. To save changes, click Save. 

6. From the Navigate menu, you may jump to many named sectors. 
These sectors are listed with the sector name and a number that is 
unique to your hard drive.  

• To jump to the unallocated boot sector, from the Navigate menu, 
choose Unallocated (<your partition size>Kb) > Boot Sector 
(<your sector number>).  

• To jump to various primary NTFS locations, from the Navigate menu, 
choose Primary NTFS (<your partition size> GB) and do one of 
the following: 

• To jump to the boot sector, click Boot Sector (<your sector 
number>). The primary boot sector appears in the editing panel. 

• To jump to the boot sector copy, click Boot Sector Copy (<your 
sector number>). The primary boot sector copy appears in the 
editing panel. 

• To edit the boot sector template, click Boot Sector (Template). 
The Edit Boot Sector Template dialog box appears. Make 
changes to the fields and click Save. 

• To jump to the MFT (Master File Table) sector, click $MFT 
(<your sector number>). The MFT sector appears in the 
editing panel.  

• To jump to the MFT mirror, click $MFT Mirror (<your sector 
number>). The MFT mirror sector appears in the editing panel. 

7. To jump to the unallocated boot sector, from the Navigate menu, 
choose Unallocated (<your partition size> Mb) > Boot Sector 
(<your sector number>). 

8. To jump to the unallocated MFT (Master File Table) sector, from the 
Navigate menu, choose $MFT (<your sector number>). The MFT 
sector appears.  

9. To jump to the MFT Mirror sector, from the Navigate menu, choose 
$MFT Mirror (<your sector number>). The MFT Mirror sector 
appears. 

 

2.2.5.5 Editing tools 
You may paste code or text from the Windows Clipboard. Use these tools to 
copy and paste selected code.  

To use editing tools: 
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1. To toggle whether or not to allow editing in the editing pane, from the 
Edit menu, choose Allow Edit content. 

2. To select a whole sector: 

a. Click anywhere in a sector. 

b. From the Edit menu, choose Select Sector. The whole sector is 
selected. 

3. To select part of a sector, click and drag the cursor over some code. You 
may select code this way in either the HEX area or in the text area. 

4. To copy HEX data, if you selected code in the HEX area, from the Edit 
menu, choose Copy HEX. Selected HEX data is copied to the Clipboard. 

5. To copy text data, if you selected code in the text area, from the Edit 
menu, choose Copy Text. Selected text data is copied to the Clipboard. 

6. To copy both HEX and text data: 

a. Select some data, using one of the methods above. 

b. From the Edit menu, choose Copy Screen. Selected data is copied 
to the Clipboard. 

7. To paste data from the Clipboard: 

a. Click the cursor in the area where you want to paste data. 

b. From the Edit menu, choose Paste. The data appears. 

8. To discard all changes that you have not saved yet (if any were made) 
and roll back settings to the way they were at the last save, from the 
Edit menu, click Revert All. 

9. To save changes, click Save. 

Note  By default, you cannot edit content in Active@ HEX Editor. You must 
choose "Allow Edit Content" in the Edit menu in order to change the code. 

 

2.3 Data Security Utility 
Active@ KillDisk is a quality security application that destroys data 
permanently from any computer. This utility can destroy all data on all 
storage devices.  

Active@ KillDisk conforms to four international standards for clearing and 
sanitizing data. You can be sure that after you erase a disk with Active@ 
KillDisk, sensitive information is destroyed forever. 

You may use Active@ KillDisk to: 

• Erase data permanently, with no chance of recovery 

• Wipe deleted data, securely removing all data in unoccupied sectors 
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2.3.1 Active@ KillDisk Help 
Active@ KillDisk is a powerful utility that will:  

• Wipe confidential data from unused space on your hard drive  

• Erase data from partitions or from an entire hard disk  

• Destroy data permanently  

Wiping the logical drive's deleted data does not delete existing files and 
folders. It processes all unoccupied drive space so that data recovery of 
previously deleted files becomes impossible. Installed applications and 
existing data are not touched by this process. Active@ KillDisk wipes unused 
data residue from file slack space, unused sectors, and unused space in MTF 
records or root records. 

When you erase data with Active@ KillDisk, you destroy data permanently, 
conforming to any one of six international standards or your own custom 
settings. 

Wiping drive space or erasing data can take a long time, so perform these 
operations when you are prepared to wait. For example, these operations 
may be run overnight. 

 

To run Active@ KillDisk: 

1. From the Active@ Boot Disk shell, click Data Security > Active@ 
KillDisk. After initializing, the Active@ KillDisk workspace appears 
with all available devices listed under System Local Disks. 

2. Click a physical drive or a logical drive to select it. Properties of the 
selected device appear in the Properties tab to the right. 

3. To scan the selected logical drive, click Scan. The Progress tab 
appears, showing the status of the scan while Time Left counts down 
the remaining time.  

After the scan completes, sub-folders appear in the System Local Disks 
list and the folders and files in the selected drive appear in the Folders 
and Files tab. 

Available files and folders appear with a coloured icon. Deleted files and 
folders appear with a gray icon. 

4. After the scan has completed, you may do the following: 

• Select existing and deleted folder and file information in the Folders 
and Files tab. 

• To view sectors of data in a device or logical drive, select a device or 
drive and click View data. The Data Viewer appears. Scroll through 
the available data. 

2.3 Data Security Utility  31 



• To view sectors of data in a file: 

a. Select a logical drive. Files and folders appear in the right panel. 

b. In the right panel, select a file. 

c. Click View data. The Data Viewer appears. Scroll through the 
available data. 

• To clear data residue from unused sectors: 

a. Select the check box next to a device or logical drive or multiple 
devices or logical drives. 

b. Click Wipe. The Wipe Free Disk Space dialog box appears.  

c. Choose a method from the Wipe Method drop-down list. (Method 
descriptions appear below.) 

d. Set other parameters for wiping. (Parameter descriptions appear 
below.)  

e. Click Start.  
• If the Skip Confirmation check box is clear, the Confirm 

Action dialog box appears. 
• Click Yes. 

f. The Progress bar appears. 

g. To stop the process at any time, press ESC. 

• To erase data completely: 

a. Select the check box next to a device or logical drive or multiple 
devices or multiple logical drives. 

b. Click Kill. The Kill dialog box appears.  

c. Choose a method from the Erase Method drop-down list. (Method 
descriptions appear below.) 

d. Set other parameters for erasing. (Parameter descriptions appear 
below.)  

e. Click Start.  
• If the Skip Confirmation check box is clear, the Confirm 

Action dialog box appears. 
•  This is the final step before removing data from the selected drive 

for ever. Type ERASE-ALL-DATA in the text box and press 
ENTER or click YES. 

f. The Progress bar appears. 

g. To stop the process at any time, press ESC. 

After the Wipe or Kill operation is complete, information about the wipe or 
erase session is displayed in the Session Log. 

2.3.1.1 Wiping or Erasing Methods 
Select a wipe method or an erase method from the Method drop-down list.  
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One Pass Zeros or One Pass Random: The number of passes is fixed 
and cannot be changed. When the write head passes through a sector, it 
writes only zeros or a series of random characters.  

US DoD 5220.22-M: The write head passes over each sector three times. 
The first time with zeros (0x00), second time with 0xFF and the third time 
with random characters. There is one final pass to verify random characters 
by reading.  

German VSITR: The write head passes over each sector seven times. 

Russian GOST p50739-95: The write head passes over each sector five 
times.  

Gutmann: The write head passes over each sector 35 times. 

User Defined: You indicate the number of times the write head passes over 
each sector. Each overwriting pass is performed with a buffer containing 
random characters.  

 

2.3.1.2 Parameters for Wiping or Erasing 
Verification: To set the amount of area the utility reads to verify the wipe 
method, select the Verification check box. Because verification is a long 
process, you may specify a percentage of the surface to be verified. To wipe 
or erase without verification, clear this check box.  

Retry Attempts: To specify the number of retries to do when an error is 
encountered, enter the number in Retry Attempts.  

Ignore Errors: To hide error messages while data wiping, erasing or 
verification is in progress, select the Ignore Errors check box. To show all 
error messages during wiping, erasing or verification, clear the Ignore Errors 
check box. All errors are written to the session log in either case.  

Clear Log File before Start: To truncate the session log before erasing or 
wiping starts, select the Clear Log File before Start check box. To append 
this session’s information to the existing session log, clear the Clear Log File 
before Start check box.  

Skip Confirmation: The confirmation dialog box is the final step before 
either erasing or wiping data. To bypass this dialog box, select the Skip 
Confirmation check box. To include this safety step, clear the Skip 
Confirmation check box. It is safer to run Active@ KillDisk with this check 
box cleared (default state).  

Initialize device(s) after Kill: This check box appears only when you are 
erasing data from a disk. Before you can use a disk, you must initialize it. To 
initialize a disk as a basic disk automatically after the erasing process, select 
this check box. To initialize a disk as a basic disk manually, clear this check 
box. 

Wipe unused space in MFT/Root area: This check box appears only 
when you are wiping data from unused space on the drive. To clear data 
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residue from unoccupied space in the MFT (Master File Table)/Root area on 
the drive, select this check box. To skip this area, clear the check box. 

Wipe slack space in file clusters: This check box appears only when you 
are wiping data from unused space on the drive. For a more thorough wiping 
of data residue from unused portions of clusters without touching existing 
data, select this check box. For a quick process, clear this check box.  

 

2.4 Network Operations Utilities 
This section describes the following: 

2.4.1 Map Network Drive - A Mapped Drive is typically a place on a 
network server's hard drive that has been created or designated as a shared 
folder and assigned a local drive letter. It is given specific permissions of use 
as the folder will store information for particular users or groups. 

 

2.4.2 View Network Status - ipconfig (IP Configuration) in Windows is a 
utility to print the local computer's current network configuration and to 
control the Windows Service that acts as its DHCP (Dynamic Host 
Configuration Protocol) Client. DHCP is a set of rules used by 
communications devices such as a computer, router or network adapter to 
allow the device to request and obtain an IP address from a server which 
has a list of addresses available for assignment. 

 

2.4.3 Network Configurator - In computer networking, the ARP (Address 
Resolution Protocol) is the method for finding a host's hardware address 
when only its network layer address is known. Use the Network Configurator 
utility to configure IP settings and Windows firewall settings. 

 

2.4.4 Remote Desktop Connection - As part of Microsoft Terminal 
Services, use this utility to allow a remote user to take control of your 
computer (Remote Desktop). Microsoft provides the client software Remote 
Desktop Connection for most Windows operating systems that allows a user 
to connect to and work with a remote server running Terminal Services. 

 

2.4.1 Map Network Drive 
To map a network drive: 

1. From the Active@ Boot Disk shell, click Network > Map Network 
Drive. The Map Network Drive dialog box appears.  

2. In Drive, select a drive letter.  
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3. In Folder, type the server and share name of the computer or folder 
you want. For example: \\servername\sharename.  

4. To search for the computer or folder, click Browse.  

5. If it is necessary to change the user name in order to map the selected 
drive, do the following: 

a. Click the link at Connect using a different name. The Connect 
As... dialog box appears.  

b. Enter the domain name and the user name that has permission to 
connect to the selected computer or folder.  

c. Enter the password for the user named above.  

6. Click OK to return to the Map Network Drive dialog box.  

7. To reconnect to the mapped drive every time you log on, select the 
Reconnect at logon check box.  

8. Click Finish.  

Note  Mapped drives are available only when the host computer is available. 
Network drives are assigned letters from Z to A, and local drives (your 
hard drive and removable storage devices) are assigned letters from A to 
Z. You can assign a computer or shared folder to a different drive letter 
by disconnecting from the drive and then reassigning it to a new drive 
letter.   

 

2.4.2 View Network Status 
This utility works only on computers with network adapters.  

The ipconfig utility displays current TCP/IP network configuration values, 
updates, or releases, DHCP (Dynamic Host Configuration Protocol) allocated 
leases, and display, register, or flush DNS (Domain Name System) names. 

 

To view the status of a local area connection: 

1. From the Active@ Boot Disk shell, click Network > View Network 
Status. The View Network Status DOS session appears showing 
Windows IP Configuration. 
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2. To close the DOS session, press a key on the keyboard.  

 

 

2.4.3 Network Configurator 
This utility works only on computers with adapters that are configured to 
obtain an IP address automatically. It renews DHCP configuration for all 
adapters. 

 

To configure the IP address: 

1. From the Active@ Boot Disk shell, click Network > Network 
Configurator. The Network Configurator dialog box appears. 

2. From the Ethernet Adapters drop-down list, select an adaptor.  

3. To view details about the selected adaptor, hover the mouse over the 
Ethernet Adapters field. A drop-down text screen appears. 

4. In the IP tab, do the following: 

• To get an IP address automatically from the network server, select the 
Obtain an IP address automatically radio button. 
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• To use a specific IP address, select the Use the following IP 
address radio button and type the information in the fields below. 

5. In the DNS tab, do the following: 

• To get a DNS automatically from the network server, select the 
Obtain DNS Server address automatically radio button. 

• To use a specific DNS address, select the Use the following DNS 
Server address radio button and type the information in the fields 
below. 

6. In the Network Identification tab, to specify a workgroup for group 
access, type the workgroup name in the Workgroup field and click Set. 

7. In the Firewall tab, you may set the status of the firewall in the Firewall 
status drop-down list: 

• To turn the firewall on, choose On. 

• To turn the firewall off, choose Off. 

 

2.4.4 Remote Desktop Connection 
To use this utility, Remote Desktop Web Connection must be installed 
and running on the Web server.  

Use the Active@ Boot Disk View Network Status utility to ensure that 
your client computer has an active network connection and that the WINS 
server service (or other name resolution method) is functioning.  

To connect to another computer using Remote Desktop Web Connection: 

1. From the Active@ Boot Disk shell, click Network > Remote Desktop 
Connection. The Remote Desktop Connection dialog box appears.  

2. In the Computer field, type the URL for the home directory of the Web 
server hosting Remote Desktop Web Connection.  

3. To set more parameters for the connection, click Options >> and 
specify information for your connection.  

4. Click Connect. 

 

2.5 Utilities 
Use these utilities to explore parameters around existing hard drives. 

 

Active@ Hard Disk Monitor – Check various attributes of hard drives in 
the system. 
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Active@ Partition Manager – Create, delete, format and name partitions 
for devices in the system. 

 

Explore My Computer – Use ExplorerXP to access the file system. Copy, 
move and delete files and folders. ExplorerXP is a very fast, small, compact 
and innovative file manager. Unlike the regular Windows Explorer, it displays 
the total size of each folder and allows you to browse multiple folders from a 
tabbed interface.  

 

Notepad – Run Notepad text editor. When you are performing maintenance 
on a hard disk or if you are repairing or recovering lost or damaged data on 
a disk, you might want to record technical information about the disk before 
making changes. This information may be helpful if you need to remember 
the original configuration when restoring data after a system crash or when 
contacting technical support.   

 

Registry Editor – View and edit registry information for the current 
(Windows PE) operating system. 

 

2.5.1 Active@ Hard Disk Monitor help 
Use this utility to perform maintenance tasks on hard drives in the system. 

 Note  This is the free version of this utility and some functions are disabled. 
Some functions that are enabled apply only when using the stand-alone 
version of Active @ Hard Disk Monitor. 

To use Active@ Hard Disk Monitor: 

1. From the Active@ Boot Disk shell, click Utilities > Active@ Hard Disk 
Monitor. The Active@ Hard Disk Monitor workspace appears. 

2. To change the settings of the utility, click Preferences. The 
Preferences dialog box appears. Do the following: 

a. In the Poll settings tab: 

• To change the frequency for checking status of the device, make 
changes in the Check every fields. 

• To change the frequency for checking the amount of free disk 
space, make changes in the Check Free Disk Space every 
fields. 

• To show which disk to monitor, choose it from the Disk drop-
down list. 

• To start Active@ Hard Disk Monitor when Windows starts, select 
the Enable at Windows startup check box. 
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b. In the Environment tab: 

• To change how drive temperature is displayed, choose a different 
setting in the Show temperature in drop-down list. 

• To change the appearance of the workspace, choose a different 
setting in the Style drop-down list. 

• The Hard Disk Monitor tray icon can show three states. To change 
the default color for each of these states, change them in the 
TrayIcon color drop-down lists. 

3. From the Local System Disks list, click a device to select it. 
Information about the selected device appears in the right panel. 

4. To display attributes about the device, click the Disk Info tab. 
Attributes appear in the panel. 

5. To display SMART attributes, click the SMART Info tab. Performance 
and health attributes appear in the panel. 

6. To scan the selected device to detect bad blocks, click the Scan Disk 
tab and do the following: 

a. To change the block size, in the Check Block Size area, choose a 
different size. 

b. To specify a start sector and a stop sector for the scan, type the 
sector numbers in the From sector and To sector fields. 

c. Click Start Scan. The progress bar indicates progress of the scan. 

d. To stop the scan at any time, click Stop Scan. 

e. After the scan is complete, the Scan Disk Complete message box 
appears with details of the scan. 

f. To view a list of events run in the session, click Event Log. A list of 
events appears in the panel. 

 

2.5.2 Active@ Partition Manager help 
Use this utility to perform maintenance tasks on hard drive partitions. 

To use Active@ Partition Manager: 

1. From the Active@ Boot Disk shell, click Utilities > Active@ Partition 
Manager. The Active@ Partition Manager workspace appears. 

2. From the Data Storage Devices and Partitions list, click a device to 
select it. 

3. To view the properties of the selected device, click Properties. The 
device properties report box appears. To close it, click OK. 

4. To create a partition: 

a. On a hard disk device, click an Unallocated area in the list to select 
it. 
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b. Click Create. The Create Partition dialog box appears. 

c. At the top of the dialog box, select the partition type. It may be one 
of:  

• Primary Partition 
• Extended Partition 
• Logical Drive in the extended partition 

d. In Partition geometry, type the partition offset (in sectors) and the 
partition size (in megabytes).  

• To use the maximum available size for this partition, in Partition 
size in MB type 0.  

e. In Drive Letter, select a drive letter from the drop-down list. 

f. To format this partition, select the Format this partition with the 
following settings radio button and set parameters for the format 
action. 

g. To leave the partition unformatted, click the Do not format this 
partition radio button. 

h. Click OK. The partition is created. 

5. To delete a partition: 

a. Click a partition in the list to select it. 

b. Click Delete. A confirmation message appears. 

c. Click Yes. The partition is deleted. 

6. To format a partition: 

a. Click a partition in the list to select it. 

b. Click Format. The Format dialog box appears. 

c. Give the partition a volume label in Volume Label. 
d. Select a file system type in the File System drop-down list. 

e. Select an allocation unit size in the Allocation unit size drop-down 
list. 

f. To perform a quick format, select the Perform a quick format 
check box. 

g. To perform a full format, clear the Perform a quick format check 
box. 

h. Click OK. A progress bar appears. 

7. To change the letter for a device, 

a. Click a device in the list to select it. 

b. Click Change Letter. The Change Drive Letter dialog box appears 
with the first available letter selected.  

c. To change the drive letter, select a letter from the Assign the 
following drive letter drop-down list. 

40  Active@ Boot Disk User Guide 



2.5.3 Registry Editor help 

d. Click OK. The letter is assigned. 

 

2.5.3 Registry Editor help 
 

You can review and change local registry parameters after loading a registry 
hive from any partition that is detected by Active@ BootDisk utilities. If your 
computer cannot complete a boot-up and if the boot failure is related to 
registry parameters of a driver or another bootable configuration, you may 
be able to fix it by changing registry parameters using Registry Editor. 

 

To use Registry Editor: 

1. From the Active@ Boot Disk shell, click Utilities > Registry Editor. 
The Registry Editor workspace appears. 

2. In the registry hierarchy list, choose either HKEY_LOCAL_MACHINE 
or HKEY_USERS hive.  

3. From the File menu, choose Load Hive… The Load Hive dialog box 
appears. 

4. Browse to a primary logical drive (for example, C:) and navigate to 
Windows\System32\config. Contents of the config folder appear. 

5. Choose a registry hive. For example choose one of: 

• SYTEM 

• COMPONENTS 

• SOFTWARE 

6. Click Open. The Load Hive dialog box appears. 

7. In Key Name, type a custom name for the hive that you are loading. 
For example MY_SOFTWARE_HIVE. 

8. Click OK. The new hive appears in the registry hierarchy under the root 
level that you selected in step 2. 

9. Open the loaded hive and view and edit registry values, create new 
entries and keys or delete values and keys. 

10. After you have completed all the changes in the loaded hive, close 
Registry Editor. All changes are written to the registry hive that was 
attached. 

11. Exit Active@ Boot Disk and restart the computer. 
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2.6 System 
Many of these utilities are familiar Windows functions. With Active@ Boot 
Disk, you can access them even if your hard drive is damaged. 

 

Windows Task Manager – Get information about computer performance 
and details about running applications, processes, network activity, logged-in 
users, and system services. View or modify currently running services. View 
the full name of a process. Monitor applications and services running system 
performance and resources. 

 

Partition Manager – Command line tool to create, delete, format and 
resize basic partitions and logical partitions, and manage dynamic volumes 
and RAIDs. 

 

Partition Manager (GUI) – Same as above with a Graphical User 
Interface. 

 

Check Disk – An applet that helps you create and display a status report for 
your hard drive. 

 

Command Prompt – Run command prompt utility (cmd.exe) to create and 
run batch files or perform other DOS commands. 

 

Display Configurator – Choose the resolution and number of colors 
displayed. 

 

2.6.1 Partition Manager help 
DiskPart is a text-mode command interpreter in Windows Vista, Windows® 
XP, and the Windows Server 2003® family. This tool enables you to manage 
objects (disks, partitions, or volumes) by using scripts or direct input at a 
command prompt. 

 

This section describes: 

• 2.6.1.1 DiskPart Commands  

• 2.6.1.2 DiskPart Syntax and Parameters  

• 2.6.1.3 DiskPart Scripting  
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2.6.1.1 DiskPart Commands 
Before you can use DiskPart commands on a disk, partition, or volume, you 
must first list and then select the object to give it focus. When an object has 
focus, any DiskPart commands that you type act on that object. 

You can list the available objects and determine an object's number or drive 
letter by using the list disk, list volume, and list partition commands. The list 
disk and list volume commands display all disks and volumes on the 
computer. However, the list partition command displays only partitions on 
the disk that have focus. When you use the list commands, an asterisk (*) 
appears next to the object with focus. You select an object by its number or 
drive letter, such as disk 0, partition 1, volume 3, or volume C. 

When you select an object, the focus remains on that object until you select 
a different object. For example, if the focus is set on disk 0, and you select 
volume 8 as on disk 2, the focus shifts from disk 0 to disk 2, volume 8. Some 
commands automatically change the focus. For example, when you create a 
new partition, the focus automatically changes to the new partition. 

You can give focus only to a partition on the selected disk. When a partition 
has focus, the related volume (if any) also has focus. When a volume has 
focus, the related disk and partition also have focus if the volume maps to a 
single specific partition. If this is not the case, then focus on the disk and 
partition is lost. 

When using the DiskPart command as a part of a script, it is recommended 
that you complete all of the DiskPart operations together as part of a single 
DiskPart script. You can run consecutive DiskPart scripts, but you must allow 
at least 15 seconds between each script for a complete shutdown of the 
previous execution before running the DiskPart command again in successive 
scripts. Otherwise, the successive scripts might fail. You can add a pause 
between consecutive DiskPart scripts by adding the timeout /t 15 command 
to your batch file along with your DiskPart scripts.   

 

For more information about DiskPart, see Disk Management at the Microsoft 
TechNet Web site <http://go.microsoft.com/fwlink/?LinkID=584>. 
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2.6.1.2 DiskPart Syntax and Parameters 
This table identifies the syntax and parameters of the DiskPart commands. 

 

Command  Syntax  Description  

active  active  On basic disks, marks the partition with focus as active. This informs the 
BIOS (basic input/output system) or EFI (Extensible Firmware Interface) 
that the partition or volume is a valid system partition or system volume. 

Only partitions can be marked as "active." 

Important:  

DiskPart verifies that only the partition is 
capable of containing an operating system's 
startup files. DiskPart does not check the 
contents of the partition. If you mark a 
partition as "active" and it does not contain 
the operating system's startup files, your 
computer might not start.  

 

add disk  add disk= n [noerr] Mirrors the simple volume with focus to the specified disk. 

n  

Specifies the disk to contain the mirror. You can mirror only simple 
volumes. The specified disk must have unallocated space at least as large 
as the size of the simple volume that you intend to mirror. 

noerr  

For scripting only. When an error is encountered, specifies that DiskPart 
continues to process commands as if the error did not occur. Without the 
noerr parameter, an error causes DiskPart to exit with an error code. 
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Command  Syntax  Description  

assign  assign 
[{letter=d|mount=path
}] [noerr] 

Assigns a drive letter or mount point to the volume with focus. If no drive 
letter or mount point is specified, then the next available drive letter is 
assigned. If the assigned drive letter or mount point is already in use, an 
error is generated. 

By using the assign command, you can change the drive letter associated 
with a removable drive. 

You cannot assign drive letters to system volumes, boot volumes, or 
volumes that contain the paging file. You cannot assign a drive letter to an 
OEM partition or any GPT partition other than a basic data partition. 

letter= d  

Specifies the drive letter that you intend to assign to the volume. 

mount= path  

The mount point path that you intend to assign to the volume. 

noerr  

For scripting only. When an error is encountered, specifies that DiskPart 
continues to process commands as if the error did not occur. Without the 
noerr parameter, an error causes DiskPart to exit with an error code. 

attributes  attributes volume [{set 
| clear}] [{hidden | 
readonly | 
nodefaultdriveletter | 
shadowcopy}] [noerr] 

volume  

Displays the attributes of the selected volume. 

set  

Sets the specified attribute (hidden, read-only, nodefaultdriveletter, 
or shadowcopy volume) on the selected volume. 

clear  

Clears the specified attribute (hidden, read-only, nodefaultdriveletter, 
or shadowcopy volume) from the selected volume. 

hidden  

Specifies that the volume is hidden. 

readonly  

Specifies that the volume is read-only. 

nodefaultdriveletter  

Specifies that the volume does not receive a drive letter by default. 

shadowcopy  

Specifies that the volume is a shadow copy volume. 
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Command  Syntax  Description  

  noerr  

For scripting only. When an error is encountered, DiskPart continues to 
process commands as if the error did not occur. Without the noerr 
parameter, an error causes DiskPart to exit with an error code. 

automount  automount [enable] 
[disable] [scrub] 
[noerr] 

When enabled (the default), Windows automatically mounts the file system 
for a new basic volume when it is added to the system, and then assigns a 
drive letter to the volume. In system area network configurations, disabling 
automount prevents Windows from automatically mounting or assigning 
drive letters to any new basic volumes added to the system. 

enable  

Enables Windows to automatically mount new basic volumes added to the 
system and to assign them drive letters. 

disable  

Prevents Windows from automatically mounting any new basic volumes 
that are added to the system. 

scrub  

Removes volume mount point directories and registry settings for volumes 
that are no longer in the system. This prevents volumes that were 
previously in the system from being automatically mounted and given their 
former volume mount point(s) when they are added back to the system. 

noerr  

For scripting only. When an error is encountered, specifies that DiskPart 
continues to process commands as if the error did not occur. Without the 
noerr parameter, an error causes DiskPart to exit with an error code. 

break disk  break disk= n [nokeep] 
[noerr] 

Applies to dynamic disks only. Breaks the mirrored volume with focus into 
two simple volumes. One simple volume retains the drive letter and any 
mount points of the mirrored volume, while the other simple volume 
receives the focus so that you can assign it a drive letter. 

By default, the contents of both halves of the mirror are retained; each half 
becomes a simple volume. If you use the nokeep parameter, only one-half 
of the mirror is retained as a simple volume, while the other half is deleted 
and converted to free space. Neither volume receives the focus. 

n  

Specifies the disk that contains the mirrored volume. 
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Command  Syntax  Description  

  nokeep  

Specifies that only one of the mirrored volumes is retained; the other 
simple volume is deleted and converted to free space. Neither volume 
receives the focus. 

noerr  

For scripting only. When an error is encountered, specifies that DiskPart 
continues to process commands as if the error did not occur. Without the 
noerr parameter, an error causes DiskPart to exit with an error code. 

clean  clean [all] Removes any and all partition or volume formatting from the disk with 
focus. On master boot record (MBR) disks, only the MBR partitioning 
information and hidden sector information are overwritten. On GUID 
partition table (GPT) disks, the GPT partitioning information, including the 
Protective MBR, is overwritten; there is no hidden sector information. 

all  

Specifies that each and every sector on the disk is zeroed, which completely 
deletes all data contained on the disk. 

convert 
basic  

convert basic [noerr] Converts an empty dynamic disk into a basic disk. 

Important:  

The disk must be empty to convert it to a 
basic disk. Back up your data, and then delete 
all partitions or volumes before converting the 
disk.  

noerr  

For scripting only. When an error is encountered, specifies that DiskPart 
continues to process commands as if the error did not occur. Without the 
noerr parameter, an error causes DiskPart to exit with an error code. 

convert 
dynamic  

convert dynamic 
[noerr] 

Converts a basic disk into a dynamic disk. Any existing partitions on the 
disk become simple volumes. 

noerr  

For scripting only. When an error is encountered, specifies that DiskPart 
continues to process commands as if the error did not occur. Without the 
noerr parameter, an error causes DiskPart to exit with an error code. 
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convert gpt  convert gpt [noerr] On Itanium-based computers, converts an empty basic disk with the MBR 
(master boot record) partition style into a basic disk with the GPT (GUID 
partition table) partition style. 

Important:  

The disk must be empty to convert it to a GPT 
disk. Back up your data and then delete all 
partitions or volumes before converting the 
disk.  

noerr  

For scripting only. When an error is encountered, specifies that DiskPart 
continues to process commands as if the error did not occur. Without the 
noerr parameter, an error causes DiskPart to exit with an error code. 

convert mbr  convert mbr [noerr] On Itanium-based computers, converts an empty basic disk with the GPT 
(GUID partition table) partition style to a basic disk with the MBR (master 
boot record) partition style. 

Important:  

The disk must be empty to convert it to an 
MBR disk. Back up your data and then delete 
all partitions or volumes before converting the 
disk.  

noerr  

For scripting only. When an error is encountered, specifies that DiskPart 
continues to process commands as if the error did not occur. Without the 
noerr parameter, an error causes DiskPart to exit with an error code. 

create 
partition efi  

create partition efi 
[size=n] [offset=n] 
[noerr] 

On Itanium-based computers, creates an EFI (Extensible Firmware 
Interface) system partition on a GPT (GUID partition table) disk. After the 
partition has been created, the focus is given to the new partition. 

size= n  

Specifies the size of the partition in megabytes (MB). If no size is given, the 
partition continues until there is no more free space in the current region. 

offset= n  

Specifies the byte offset at which to create the partition. If no offset is 
given, the partition is placed in the first disk extent that is large enough to 
hold it.  
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Command  Syntax  Description  

  noerr  

For scripting only. When an error is encountered, specifies that DiskPart 
continues to process commands as if the error did not occur. Without the 
noerr parameter, an error causes DiskPart to exit with an error code. 

create 
partition 
extended  

create partition 
extended [size=n] 
[offset=n] [noerr] 

Creates an extended partition on the current drive. After the partition has 
been created, the focus automatically shifts to the new partition. Only one 
extended partition can be created per disk. This command fails if you 
attempt to create an extended partition within another extended partition. 
You must create an extended partition before you can create logical drives. 

size= n  

Specifies the size of the extended partition in megabytes (MB). If no size is 
given, then the partition continues until there is no more free space in the 
region. The size is cylinder snapped; that is, the size is rounded to the 
closest cylinder boundary. For example, if you specify a size of 500 MB, the 
partition size rounds up to 504 MB. 

offset= n  

Applies to MBR (master boot record) disks only. Specifies the byte offset at 
which to create the extended partition. If no offset is given, the partition 
starts at the beginning of the first free space on the disk. The offset is 
cylinder snapped; that is, the offset is rounded to the closest cylinder 
boundary. For example, if you specify an offset that is 27 MB and the 
cylinder size is 8 MB, the offset is rounded to the 24-MB boundary. 

noerr  

For scripting only. When an error is encountered, specifies that DiskPart 
continues to process commands as if the error did not occur. Without the 
noerr parameter, an error causes DiskPart to exit with an error code. 

create 
partition 
logical  

create partition logical 
[size=n] [offset=n] 
[noerr] 

Creates a logical drive in the extended partition. After the partition has 
been created, the focus automatically shifts to the new logical drive. 

size= n  

The size of the logical drive in megabytes (MB). If no size is given, then the 
partition continues until there is no more free space in the current region. 
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  offset= n  

Applies to MBR (master boot record) disks only. Specifies the byte offset at 
which to create the logical drive. The offset is cylinder snapped; that is, the 
offset rounds up to completely fill whatever cylinder size is used. If no 
offset is given, then the partition is placed in the first disk extent that is 
large enough to hold it. The partition is at least as long in bytes as the 
number specified by size=n. If you specify a size for the logical drive, it 
must be smaller than the extended partition. 

noerr  

For scripting only. When an error is encountered, specifies that DiskPart 
continues to process commands as if the error did not occur. Without the 
noerr parameter, an error causes DiskPart to exit with an error code. 

create 
partition 
msr  

create partition msr 
[size=n] [offset=n] 
[noerr] 

On Itanium-based computers, creates a Microsoft reserved (MSR) partition 
on a GPT (GUID partition table) disk. 

Caution:  

Be very careful when using the create 
partition msr command. GPT disks require a 
specific partition layout, and so creating 
Microsoft Reserved Partitions can cause the disk 
to become unreadable. On GPT disks that are 
used to start Windows XP 64-Bit Edition or the 
64-bit versions of the Windows Server 2003 
family, the EFI system partition is the first 
partition on the disk, followed by the Microsoft 
Reserved Partition. GPT disks used only for data 
storage do not have an EFI system partition; the 
Microsoft Reserved Partition is the first partition.  

Windows XP and the Windows Server 2003 family do not mount Microsoft 
Reserved Partitions. You cannot store data on them and you cannot delete 
them. 

size= n  

Specifies the size of the partition in megabytes (MB). The partition is at 
least as long in bytes as the number specified by size=n. If no size is 
given, the partition continues until there is no more free space in the 
current region. 

offset= n  

Specifies the byte offset at which to create the partition. The partition starts 
at the byte offset specified by offset=n. It is sector-snapped; that is, the 
offset rounds up to completely fill whatever sector size is used. If no offset 
is given, then the partition is placed in the first disk extent that is large 
enough to hold it. 
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Command  Syntax  Description  

  noerr  

For scripting only. When an error is encountered, specifies that DiskPart 
continues to process commands as if the error did not occur. Without the 
noerr parameter, an error causes DiskPart to exit with an error code. 

create 
partition 
primary  

create partition 
primary [size=n] 
[offset=n] 
[ID={byte|GUID}] 
[align=n][noerr] 

Creates a primary partition on the current basic disk. After you create the 
partition, the focus automatically shifts to the new partition. The partition 
does not receive a drive letter; you must use the assign command to 
assign a drive letter to the partition. 

size= n  

Specifies the size of the partition in megabytes (MB). If no size is given, the 
partition continues until there is no more unallocated space in the current 
region. The size is cylinder snapped; that is, the size rounds to the closest 
cylinder boundary. For example, if you specify a size of 500 MB, the 
partition size rounds up to 504 MB. 

offset= n  

Specifies the byte offset at which to create the partition. If no offset is 
given, the partition starts at the beginning of the first free space on the 
disk. For MBR (master boot record) disks, the offset is cylinder snapped; 
that is, the offset rounds to the closest cylinder boundary. For example, if 
you specify an offset that is 27 MB and the cylinder size is 8 MB, the offset 
rounds to the 24-MB boundary. 

ID={byte|GUID} 

Intended for OEM use only. 

Caution:  

Creating partitions with this parameter might 
cause your computer to crash or be unable to 
start. Unless you are an OEM or an IT 
professional experienced with GPT disks, do 
not create partitions on GPT disks by using the 
ID=byte | GUID parameter. Instead, always 
use the create partition efi command to 
create EFI system partitions, the create 
partition msr command to create Microsoft 
Reserved Partitions, and the create partition 
primary command (without the ID=byte | 
GUID parameter) to create primary partitions 
on GPT disks.  
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  align= n  

Typically used with hardware RAID Logical Unit Number (LUN) arrays to 
improve performance when the logical units (LUs) are not cylinder aligned. 
Aligns a primary partition that is not cylinder aligned at the beginning of a 
disk and rounds the offset to the closest alignment boundary, where n is 
the number of kilobytes (KB) from the beginning of the disk to the closest 
alignment boundary. The align= n command fails if the primary partition is 
not at the beginning of the disk. If used with offset= n, the offset is within 
the first usable cylinder on the disk. 

noerr  

For scripting only. When an error is encountered, specifies that DiskPart 
continues to process commands as if the error did not occur. Without the 
noerr parameter, an error causes DiskPart to exit with an error code. 

Comments  

To partition a GPT disk with an OEM partition generate an OEM-GUID: 

Use this command to create an EFI partition: 

create partition efi size= n  

Use this command to create a primary partition:  

create partition primary size= n ID={byte|GUID} 

Use this command to create an MSR partition: 

create partition MSR size= n  

Important:  

You must create the OEM partition between 
the EFI and MSR partitions.  

Never create the LDM metadata or LDM data partitions explicitly as 
partitions. Instead, convert the disk to dynamic. 
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Command  Syntax  Description  

  For MBR (master boot record) disks, you can specify a partition type byte, 
in hexadecimal form, for the partition. If you do not specify a partition type 
byte on an MBR disk, the create partition primary command creates a 
partition of type 0x6. Any partition type byte can be specified with the 
ID=byte | GUID parameter. DiskPart does not verify the validity of the 
partition type nor does it verify the ID parameter. 

• For GPT disks, you can specify a partition type GUID for the partition that 
you create. 

• EFI system partition: c12a7328-f81f-11d2-ba4b-00a0c93ec93b 
• Microsoft reserved partition: e3c9e316-0b5c-4db8-817d-f92df00215ae 
• Basic data partition: ebd0a0a2-b9e5-4433-87c0-68b6b72699c7 
• LDM metadata partition on a dynamic disk: 5808c8aa-7e8f-42e0-85d2-

e1e90434cfb3 
• LDM data partition on a dynamic disk: af9b60a0-1431-4f62-bc68-

3311714a69ad 

If you do not specify a partition type GUID, the create partition primary 
command creates a basic data partition. Any partition type can be specified 
with the ID=byte | GUID parameter. DiskPart does not verify the validity 
of the partition GUID nor does it verify the ID parameter. 

create 
volume raid  

create volume raid 
[size=n] 
[disk=n,n,n[,n,…]] 
[noerr] 

Creates a RAID-5 volume on three or more specified dynamic disks. After 
you create the volume, the focus automatically shifts to the new volume. 

size= n  

Specifies the amount of disk space, in megabytes (MB), that the volume 
occupies on each disk. If no size is given, the largest possible RAID-5 
volume is created. The disk with the smallest available contiguous free 
space determines the size for the RAID-5 volume and the same amount of 
space is allocated from each disk. The actual amount of usable disk space 
in the RAID-5 volume is less than the combined amount of disk space 
because some of the disk space is required for parity. 

 

 
 
 

2.6 System  53 



 

Command  Syntax  Description  

  disk= n , n , n[,n,…] 

Specifies the dynamic disks on which to create the volume. You need at 
least three dynamic disks in order to create a RAID-5 volume. An amount of 
space equal to size=n is allocated on each disk. 

noerr  

For scripting only. When an error is encountered, specifies that DiskPart 
continues to process commands as if the error did not occur. Without the 
noerr parameter, an error causes DiskPart to exit with an error code. 

create 
volume 
simple  

create volume simple 
[size=n] [disk=n] 
[noerr] 

Creates a simple volume. After you create the volume, the focus 
automatically shifts to the new volume. 

size= n  

Specifies the size of the volume in megabytes (MB). If no size is given, the 
new volume takes up the remaining free space on the disk. 

disk= n  

Specifies the dynamic disk on which to create the volume. If no disk is 
given, the current disk is used. 

noerr  

For scripting only. When an error is encountered, specifies that DiskPart 
continues to process commands as if the error did not occur. Without the 
noerr parameter, an error causes DiskPart to exit with an error code. 

create 
volume 
stripe  

create volume stripe 
[size=n] 
[disk=n,n[,n,…]] [noerr] 

Creates a striped volume by using two or more specified dynamic disks. 
After you create the volume, the focus automatically shifts to the new 
volume. 

size= n  

Specifies the amount of disk space, in megabytes (MB), that the volume 
occupies on each disk. If no size is given, the new volume takes up the 
remaining free space on the smallest disk and an equal amount of space on 
each subsequent disk. 

disk= n , n[,n,…] 

Specifies the dynamic disks on which to create the volume. You need at 
least two dynamic disks to create a striped volume. An amount of space 
equal to size=n is allocated on each disk. 

noerr  

For scripting only. When an error is encountered, specifies that DiskPart 
continues to process commands as if the error did not occur. Without the 
noerr parameter, an error causes DiskPart to exit with an error code. 
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Command  Syntax  Description  

delete disk  delete disk [noerr] 
[override] 

Deletes a missing dynamic disk from the disk list. 

noerr  

For scripting only. When an error is encountered, specifies that DiskPart 
continues to process commands as if the error did not occur. Without the 
noerr parameter, an error causes DiskPart to exit with an error code. 

override  

Enables DiskPart to delete all simple volumes on the disk. If the disk 
contains half of a mirrored volume, the half of the mirror on the disk is 
deleted. The delete disk override command fails if the disk is a member 
of a RAID-5 volume. 

delete 
partition  

delete partition [noerr] 
[override] 

On a basic disk, deletes the partition with focus. You cannot delete the 
system partition, boot partition, or any partition that contains the active 
paging file or crash dump (memory dump). 

Caution:  

Deleting a partition on a dynamic disk can delete 
all dynamic volumes on the disk, thus destroying 
any data and leaving the disk in a corrupted 
state. To delete a dynamic volume, always use 
the delete volume command instead.  

You can delete partitions from dynamic disks, but you must not create 
them. For example, it is possible to delete an unrecognized GPT (GUID 
partition table) partition on a dynamic GPT disk. However, deleting such a 
partition does not cause the resulting free space to become available. This 
command is intended to enable space reclamation on a corrupted, offline 
dynamic disk in an emergency situation where the clean command cannot 
be used. 

noerr  

For scripting only. When an error occurs, specifies that DiskPart continues 
to process commands as if the error did not occur. Without the noerr 
parameter, an error causes DiskPart to exit with an error code. 

override  

Enables DiskPart to delete any partition regardless of type. Normally, 
DiskPart enables you to delete only known data partitions. 
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delete 
volume  

delete volume [noerr] Deletes the selected volume. You cannot delete the system volume, boot 
volume, or any volume that contains the active paging file or crash dump 
(memory dump). 

noerr  

For scripting only. When an error occurs, specifies that DiskPart continues 
to process commands as if the error did not occur. Without the noerr 
parameter, an error causes DiskPart to exit with an error code. 

detail disk  detail disk  Displays the properties of the selected disk and the volumes on that disk. 

detail 
partition  

detail partition  Displays the properties of the selected partition. 

detail 
volume  

detail volume  Displays the disks on which the current volume resides. 

exit  exit  Exits the DiskPart command interpreter. 

extend  extend [size=n] 
[disk=n] [noerr] 

Extends the volume with focus into the next contiguous unallocated space. 
For basic volumes, the unallocated space must be on the same disk as, and 
must follow (have a higher sector offset number than) the partition with 
focus. A dynamic, simple, or spanned volume can be extended to any 
empty space on any dynamic disk. By using this command, you can extend 
an existing volume into newly created space. 

If the partition was previously formatted with the NTFS file system, the file 
system is automatically extended to occupy the larger partition. No data 
loss occurs. If the partition was previously formatted with any file system 
format other than NTFS, the command fails with no change to the partition. 

You cannot extend the current system or boot partitions. 

size= n  

Specifies the amount of space, in megabytes (MB), to add to the current 
partition. If you do not specify a size, the disk is extended to take up all of 
the next contiguous unallocated space. 

disk= n  

Specifies the dynamic disk on which to extend the volume. An amount of 
space equal to size=n is allocated on the disk. If no disk is specified, the 
volume is extended on the current disk. 
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Command  Syntax  Description  

  noerr  

For scripting only. When an error occurs, specifies that DiskPart continues 
to process commands as if the error did not occur. Without the noerr 
parameter, an error causes DiskPart to exit with an error code. 

gpt 
attributes  

gpt attributes= n  On basic GPT disks, assigns the GPT attribute(s) to the partition with focus. 
GPT partition attributes give additional information about the use of the 
partition. Some attributes are specific to the partition type GUID. 

Important:  

Changing the GPT attributes might cause your 
basic data volumes to be unmountable or fail 
to be assigned drive letters. Unless you are an 
OEM or an IT professional experienced with 
GPT disks, do not change GPT attributes.  

n  

The hexadecimal that pertains to the attribute that you intend to apply to 
the partition with focus. The GPT attribute field is a 64-bit field that 
contains two subfields. The higher field is interpreted only in the context of 
the partition ID, while the lower field is common to all partition IDs. 

All partitions have the following attribute: 

• 0x000000000000001 marks the partition as required. This indicates to all 
disk management utilities that the partition must not be deleted. The EFI 
system partition contains only those binaries necessary to start the 
operating system. This makes it easy for OEM- or operating system-specific 
binaries to be placed in other partitions. 

For basic data partitions, the following attribute is defined: 

• 0x8000000000000000 prevents the partition from having a drive letter 
automatically assigned. By default, each partition is assigned a new 
drive letter. Setting this attribute ensures that, when a disk is moved to 
a new computer, a new drive letter will not be automatically generated. 
Instead, the user can manually assign drive letters. 

Note:  
Other attributes can be added at any time.  

 

help  help  Displays a list of the available commands. 
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import  import [noerr] Imports a foreign disk group into the local computer's disk group. The 
import command imports every disk that is in the same group as the disk 
that has focus. 

noerr  

For scripting only. When an error occurs, specifies that DiskPart continues 
to process commands as if the error did not occur. Without the noerr 
parameter, an error causes DiskPart to exit with an error code. 

inactive  inactive  On basic MBR (master boot record) disks, marks the system partition or 
boot partition with focus as inactive. The computer starts from the next 
option specified in the BIOS such as the CD-ROM drive or a Pre-Boot 
eXecution Environment (PXE)-based boot environment (such as Remote 
Installation Services (RIS)) when you restart the computer. 

Caution:  

Your computer might not start without an 
active partition. Do not mark a system or boot 
partition as inactive unless you are an 
experienced user with a thorough 
understanding of the Windows Server 2003 
family.  

If you are unable to start your computer after marking the system or boot 
partition as inactive, insert the Setup CD in the CD-ROM drive, restart the 
computer, and then repair the partition by using the Fixmbr and Fixboot 
commands in the Recovery Console. 

list disk  list disk  Displays a list of disks and information about them, such as their size, 
amount of available free space, whether the disk is a basic or dynamic disk, 
and whether the disk uses the MBR (master boot record) or GPT (GUID 
partition table) partition style. The disk marked with an asterisk (*) has 
focus. 

list partition  list partition  Displays the partitions listed in the partition table of the current disk. On 
dynamic disks, these partitions may not correspond to the dynamic volumes 
on the disk. This discrepancy occurs because dynamic disks contain entries 
in the partition table for the system volume or boot volume (if present on 
the disk). Dynamic disks also contain a partition that occupies the 
remainder of the disk and reserves space for use by dynamic volumes. 

list volume  list volume  Displays a list of basic and dynamic volumes on all disks. 

 
 
 

58  Active@ Boot Disk User Guide 



2.6.1 Partition Manager help 

 

Command  Syntax  Description  

online  online [noerr] Brings an offline disk or volume with focus online. Resynchronizes the 
mirrored or RAID-5 volume with focus. 

noerr  

For scripting only. When an error occurs, specifies that DiskPart continues 
to process commands as if the error did not occur. Without the noerr 
parameter, an error causes DiskPart to exit with an error code. 

rem  rem  Provides a way to add comments to a script. For example: 

rem These commands set up 3 drives.  

create partition primary size=2048  

assign d:  

create partition extend  

create partition logical size=2048  

assign e:  

create partition logical  

assign f:  

remove  remove 
[{letter=d|mount=path
|[all]}] 
[dismount][noerr] 

Removes a drive letter or mount point from the volume with focus. If the 
all parameter is used, all current drive letters and mount points are 
removed. If you do not specify a drive letter or mount point, then DiskPart 
removes the first drive letter or mount point that it encounters. 

You can use the remove command to change the drive letter associated 
with a removable drive. You cannot remove the drive letters on system, 
boot, or paging volumes. In addition, you cannot remove the drive letter for 
an OEM partition, any GPT partition with an unrecognized GUID, or any of 
the special, non-data, GPT partitions such as the EFI system partition. 

letter= d  

Specifies the drive letter to remove. 

mount= path  

Specifies the mount point path to remove. 

all  

Removes all current drive letters and mount points. 

 
 
 

2.6 System  59 



 

Command  Syntax  Description  

  dismount  

Dismounts the basic volume, when all drive letters and mount points have 
been removed from the volume, and takes the basic volume offline, making 
it unmountable. If other processes are using the volume, DiskPart closes 
any open handles before dismounting the volume. You can make the 
volume mountable by assigning it a drive letter or by creating a mount 
point path to the volume. Dismount will fail if used on a volume that has 
any remaining drive letters or mount points. For scripting, using remove 
all dismount is recommended. 

noerr  

For scripting only. When an error occurs, specifies that DiskPart continues 
to process commands as if the error did not occur. Without the noerr 
parameter, an error causes DiskPart to exit with an error code. 

repair disk  repair disk= n [noerr] Repairs the RAID-5 volume with focus by replacing the failed RAID-5 
member with the specified dynamic disk. The specified dynamic disk must 
have free space greater than or equal to the total size of the failed RAID-5 
member. 

n  

Specifies the dynamic disk that replaces the failed RAID-5 member. The 
specified disk must have free space equal to or larger than the total size of 
the failed RAID-5 member. 

noerr  

For scripting only. When an error occurs, DiskPart continues to process 
commands as if the error did not occur. Without the noerr parameter, an 
error causes DiskPart to exit with an error code. 

rescan  rescan  Locates new disks that might have been added to the computer. 

retain  retain  Prepares an existing dynamic simple volume to use as a boot or system 
volume. 

On an x86-based computer, creates a partition entry in the MBR (master 
boot record) on the dynamic simple volume with focus. To create an MBR 
partition, the dynamic simple volume must start at a cylinder aligned offset 
and be an integral number of cylinders in size. 

On an Itanium-based computer, creates a partition entry in the GPT (GUID 
partition table) on the dynamic simple volume with focus. 

 Note:  

The retain command is intended for use only 
during unattended Setup or by OEMs. 
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select disk  select disk=[n] Selects the specified disk and shifts the focus to it. 

n  

Specifies the disk number of the disk to receive focus. If you do not specify 
a disk number, the select command lists the disk that currently has the 
focus. You can view the numbers for all disks on the computer by using the 
list disk command. 

select 
partition  

select partition=[{n|d}] Selects the specified partition and gives it focus. If you do not specify a 
partition, the select command lists the current partition with focus. You 
can view the numbers of all partitions on the current disk by using the list 
partition command. 

n  

Specifies the number of the partition to receive the focus. 

d  

Specifies the drive letter or mount point path of the partition to receive the 
focus. 

select 
volume  

select volume=[{n|d}] Selects the specified volume and shifts the focus to it. If you do not specify 
a volume, the select command lists the current volume with focus. You 
can specify the volume by number, drive letter, or mount point path. On a 
basic disk, selecting a volume also gives the corresponding partition focus. 
You can view the numbers of all volumes on the computer by using the list 
volume command. 

n  

Specifies the number of the volume to receive the focus. 

d  

Specifies the drive letter or mount point path of the volume to receive the 
focus. 

 

2.6.1.3 DiskPart Scripting 
By using the DiskPart Command-Line Options command-line tool, you can 
create scripts to automate disk-related tasks, such as creating volumes or 
converting disks to dynamic disks. Scripting these tasks is useful if you 
deploy Windows by using unattended Setup or the Sysprep tool, which do 
not support creating volumes other than the boot volume. 

To start a DiskPart script, at the command prompt, type: 

diskpart /s scriptname .txt  

where scriptname is the name of the text file that contains your script. 
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To redirect DiskPart's scripting output to a file, type: 

diskpart /s scriptname .txt > logfile .txt  

where logfile is the name of the text file where DiskPart writes its output. 

When DiskPart starts, the DiskPart version and computer name display at the 
command prompt. By default, if DiskPart encounters an error while 
attempting to perform a scripted task, DiskPart stops processing the script 
and displays an error code (unless you specified the noerr parameter). 
However, DiskPart always returns errors when it encounters syntax errors, 
regardless of whether you used the noerr parameter. The noerr parameter 
enables you to perform useful tasks such as using a single script to delete all 
partitions on all disks regardless of the total number of disks. 

The table below lists the DiskPart error codes. 

Error Description  

0 No errors occurred. The entire script ran without failure. 

1 A fatal exception occurred. There might be a serious problem. 

2 The parameters specified for a DiskPart command are incorrect. 

3 DiskPart was unable to open the specified script or output file. 

4 One of the services that DiskPart uses returned a failure. 

5 A command syntax error occurred. The script failed because an object was improperly selected or 
was invalid for use with that command. 

 

2.6.2 Check Disk help 
 

Check Disk is an applet that will help you create and display a status report 
for your hard drive. The applet also lists and corrects error on the disk.  

Similar to Windows CHKDSK, Check Disk has a list of parameters that help 
you perform various functions on your hard drive. 

 

To use Check Disk: 

1. In the Active@ Boot Disk shell, click Utilities > Check Disk. The 
Check Disk Applet workspace appears. A list of all hard drives appears 
in the Local Disks list. 

2. To select a hard drive, select the check box next to the drive name. 
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3. You may add parameters to the command: 

• /F – If an error is encountered, Check Disk will fix the issue that causes 
the error. 

• /V – On a FAT or FAT32 file system, the full path and name of every 
file is displayed. On NTFS file system, only cleanup messages are 
displayed. 

• /R – Locates bad sectors and recovers readable information. 

• /I [NTFS only] – Performs a less vigorous check of indexes. 

• /C [NTFS only] – Skips checking of cycles within the folder structure. 

• On a FAT or FAT32 file system, you may specify an individual file to 
check. To do this, click Browse and choose the file from the Select File 
dialog box. 

4. After you have selected a drive and parameters, click Add all marked 
disks. The chkdsk.exe command appears in the Command list along 
with the drive letter and all parameters. 

5. To add another drive, repeat steps 2 to 4. 

6. To remove a drive from the Command list, select it and click Delete 
command > Delete Current. 

7. To remove all drives from the Command list, click Delete command 
> Delete All. 

8. To run all commands in the Command list, click Execute. A DOS session 
appears. 

9. Watch as the functions proceed. 

After the command is complete, the DOS session closes. 

 

2.6.3 Display Configurator help 
 

To use Display Configurator: 

1. In the Active@ Boot Disk shell, click System > Display Configurator. 
The List All Modes list appears with a list of all valid modes.  

2. Click a mode to select it. The Apply button is enabled. 

3. Click Apply. The Monitor Settings dialog box appears. 

4. To keep the mode, click Yes. 

The display mode is changed. 
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2.7 Internet 
 

The Active@ Boot Disk Web utilities include: 

1. K-Meleon Web Browser – An extremely fast, customizable, lightweight web 
browser for the Windows platform. K-Meleon is free, open source software 
released under the GNU General Public License.  

For more information about K-Meleon see 
http://kmeleon.sourceforge.net/. 

2. FTP Client – A console utility to help you download or upload files from an FTP 
site. 

3. Telenet Client – A console utility to help you access remote sites in a terminal 
session. 

 

2.7.1 FTP Client 
Use Microsoft FTP Client (console) to transfer files to and from your 
computer running an FTP (File Transfer Protocol) server service such as 
Internet Information Services. FTP can be used interactively or in batch 
mode by processing ASCII text files. 

 

To open FTP client: 

1. From the Active@ Boot Disk shell, click FTP Client. The FTP Client 
DOS session appears.  

 

2.7.1.1 FTP Client Syntax and Parameters 
Syntax  

ftp [-v] [-d] [-i] [-n] [-g] [-s:FileName] [-a] [-w:WindowSize] [-A] [Host]  
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This table identifies parameters of the FTP command. 

 

Parameter Description  

-v Suppresses the display of FTP server responses. 

-d Enables debugging, displaying all commands passed between the FTP client and FTP 
server.  

-j Disables interactive prompting during multiple file transfers. 

-n Suppresses the ability to log on automatically when the initial connection is made.  

-g Disables file name globbing. Glob permits the use of the asterisk (*) and question mark (?) 
as wildcard characters in local file and path names. 

-s;FileName Specifies a text file that contains FTP commands. These commands run automatically after 
FTP starts. This parameter allows no spaces. Use this parameter instead of redirection (<). 

-a Specifies that any local interface can be used when binding the FTP data connection.  

-w WindowSize Specifies the size of the transfer buffer. The default window size is 4096 
bytes. 

-A Logs onto the FTP server as anonymous.  

Host Specifies the computer name, IP address, or IPv6 address of the FTP server to which to 
connect. The host name or address, if specified, must be the last parameter on the line. 

/? Displays help at the command prompt. 

 

Notes   

• You must prefix ftp parameters with a hyphen (-) rather than a slash (/).  
• FTP command-line parameters are case-sensitive.  
• This command is available only if the Internet Protocol (TCP/IP) protocol is installed as 

a component in the properties of a network adapter in Network Connections.  
• FTP can be used interactively. After it is started, FTP creates a subenvironment in 

which you can use FTP commands. You can return to the command prompt by typing 
the quit command. When the FTP subenvironment is running, it is indicated by the FTP 
> command prompt.  

• Ftp supports the use of IPv6 when the IPv6 protocol is installed. For more information, 
see IP version 6 and IPv6 applications. 
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Examples  

To log on to the FTP server named ftp.example.microsoft.com, type the 
following command:  

ftp ftp.example.microsoft.com  

 

To anonymously log on to the FTP server named ftp.example.microsoft.com, 
type the following command:  

ftp -A ftp.example.microsoft.com  

 

To log on to the FTP server named ftp.example.microsoft.com and run the 
ftp commands contained in a file named Resynch.txt, type the following 
command:  

ftp -s:resynch.txt ftp.example.microsoft.com  
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2.7.2 Telenet Client 
With Telnet Client, Windows users can connect to a remote computer 
running a Telnet server and run applications on the remote computer or 
perform administrative tasks on it.  

Telnet uses the Telnet protocol (part of the TCP/IP protocol suite) to connect 
to a remote computer over a network.  

 

2.7.2.1 Telnet Commands 
This table identifies syntax and parameters of the Telnet commands that you 
may use at the Telnet prompt. 

 

To do this Syntax Short Parameters 

Start Telnet Client 
and to enter the 
Telnet prompt   

telnet 
[\\RemoteServer] 

 \\RemoteServer Specifies the name of the 
server to which you want to connect.  

/? Displays help. 

Stop Telnet Client quit q none 

Connect Telnet 
Client to a remote 
computer 

open 
[\\RemoteServer] 
[Port] 

o \\RemoteServer Specifies the name of the 
server to which you want to connect. 

Port Specifies the port that you want to use. If 
you do not specify a port, the default port is 
assumed.  

Disconnect Telnet 
Client from a remote 
computer 

close 
[\\RemoteServer] 

c \\RemoteServer Specifies the name of the 
server that you want to manage. If you do not 
specify a server, the local server is assumed. 

Set Telnet Client 
options  

set 
[\\RemoteServer] 
[ntlm] [localecho] 
[term {ansi | vt100 | 
vt52 | vtnt}] [escape 
Character] [logfile 
FileName] [logging] 
[bsasdel] [crlf] 
[delasbs] [mode 
{console | stream}] 
[?] 

 \\RemoteServer Specifies the name of the 
server that you want to manage. If you do not 
specify a server, the local server is assumed. 

ntlm Turns on NTLM authentication if it is 
available on the remote server. 

localecho Turns on local echo.  

term {ansi | vt100 | vt52 | vtnt} Sets the 
terminal to the specified type.  

escape Character Sets the escape character. 
The escape character can be a single character, 
or it can be a combination of the CTRL key plus a 
character. To set a control-key combination, hold 
down CTRL while you type the character that you 
want to assign.  
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To do this Syntax Short Parameters 

   logfile FileName Sets the file to be used for 
logging Telnet activity. The log file must be on 
your local computer. Logging begins 
automatically when you set this option.  

logging Turns on logging. If no log file is set, an 
error message appears.  

bsasdel Sets BACKSPACE to be sent as delete.  

crlf Sets the new line mode, which causes the 
ENTER key to send 0x0D, 0x0A.  

delasbs Sets DELETE to be sent as backspace.  

mode {console | stream} Sets the mode of 
operation.  

? Allows you to view the complete syntax for this 
command. 

Turn off an option 
that was previously 
set, at the Telnet 
prompt 

unset [Option]   

Set the escape 
character, type 

–e Character   

Set the current code 
set to a non-English 
language 

codeset Option  Option Can be any one of the following: Shift 
JIS, Japanese EUC, JIS Kanji, JIS Kanji (78), DEC 
Kanji, NEC Kanji.  

You should set the same code set on the remote 
computer. 

Send Telnet Client 
commands 

send 
[\\RemoteServer] 
[ao] [ayt] [esc] [ip] 
[synch] [?] 

 \\RemoteServer Specifies the name of the 
server that you want to manage. If you do not 
specify a server, the local server is assumed.  

ao Aborts output command.  

ayt Sends an "Are you there?" command.  

esc Sends the current escape character.  

ip Interrupts the process command.  

synch Performs the Telnet sync operation.  

? Allows you to view the complete syntax for this 
command.  
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2.7.2 Telenet Client 

 

To do this Syntax Short Parameters 

View the current 
settings for the 
Telnet client 

display  The display command lists the current operating 
parameters. If you are in a Telnet session 
(connected to a Telnet server), to modify the 
parameters, press CTRL+]. This escapes from the 
Telnet session. (To return to the Telnet session, 
press ENTER.)  

The following operating parameters are available: 

- WILL AUTH (NTLM Authentication)  

- WONT AUTH  

- WILL TERM TYPE  

- WONT TERM TYPE  

- LOCALECHO off  

- LOCALECHO on 

 

To switch from Telnet Client to command mode, at the Telnet prompt, press 
CTRL+ ]. To switch back to Telnet Client, press ENTER. 
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2.8 Load Drivers 
Load Drivers will help if you have SCSI drive controllers or an older or 
uncommon RAID type. Load Drivers will also help if you cannot find any 
other type of driver, for example, video driver, sound card driver, etc. 

If you have successfully booted from the CD and you do not see your C: 
drive because it is a Stripe Array (Raid-0) or if you are using an older or non-
standard controller the Load Drivers dialog box appears. Do the following: 

1. In the Active@ Boot Disk shell, click Load Drivers. The Active@ Driver 
Installer dialog box appears.  

2. In the INF file field, enter the path to the driver information file. 

3. To browse to the file, click Browse. 

4. If you do not have the driver information file on the current drive, do the 
following: 

• Load a CD with the correct drivers into the CD drive or plug a USB 
device with the correct drivers into a USB port. 

• Use one of the Web utilities to download the driver from an Internet 
URL and save it to your hard drive.  

• In the INF file field, enter the path to the driver information file.  

5. Click INSTALL DRIVER!  

 

After the driver is installed, if you needed a driver for your hard disk, you 
should be able to see your C: drive in Windows Explorer after you refresh its 
tree content. Similarly, you should be able to see and use any other driver 
that you have installed. 

Note  You may load drivers automatically at boot time. For more information, 
see 1.4 BootDisk_Drivers and BootDisk_Scripts. 
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3.0 About Boot Priority 

To boot from a CD, DVD or USB device, make sure that the device has the 
boot sequence priority over the hard drive. 

 

BIOS (Basic Input Output Subsystem) is a programmable chip that controls 
how information is passed to various devices in the computer system. A 
typical method to access the BIOS settings screen is to press ESC, F1, F2, F8 
or F10 during the boot sequence. 

 

BIOS settings allow you to run a boot sequence from a floppy drive, a hard 
drive, a CD-ROM drive or an external device. You may configure the order 
that your computer searches these physical devices for the boot sequence. 
The first device in the order list has the first boot priority. For example, to 
boot from a CD-ROM drive instead of a hard drive, place the CD-ROM drive 
ahead of the hard drive in priority. 

 

While you are in the BIOS Setup Utility, you will not be able to use your 
mouse. Use the keyboard arrow keys to move around the screen. 

 

Before you set boot priority for a USB device, plug the device into a USB 
port. 

To specify the boot sequence: 

1. Start the computer and press ESC, F1, F2, F8 or F10 during the initial 
startup screen. Depending on the BIOS manufacturer, a menu may 
appear. 

2. Choose to enter BIOS setup.  The BIOS setup utility page appears. 

3. Use the arrow keys to select the BOOT tab. System devices appear in 
order of priority. 

4. To give a CD or DVD drive boot sequence priority over the hard drive, 
move it to the first position in the list. 

5. To give a USB device boot sequence priority over the hard drive, do the 
following: 

• Move the hard drive device to the top of the boot sequence list. 

• Expand the hard drive device to display all hard drives. 

• Move the USB device to the top of the list of hard drives. 

6. Save and exit the BIOS setup utility. 

The computer will restart with the changed settings. 

 



Some computer manufacturers allow you to select the device that contains 
the boot sequence from a special device selection menu. The example below 
uses a Dell system board. 

 

To set boot priority using a device selection menu: 

1. When the computer starts to boot up, after the manufacturer's ID 
screen, press F12 several times. The device selection menu appears.   

2. Use the up and down arrows to select CD-ROM.  

3. To boot from the selected device, press ENTER.  

 Note  Using an incorrect BIOS setting can cause a system malfunction. Please 
follow the BIOS guide provided with your computer motherboard. If you 
read these instructions and you are not sure how to change a setting, it is 
better to leave it as the default setting.  
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4.0 Glossary 

BIOS settings Basic Input Output Subsystem. Programmable chip that controls how 
information is passed to various devices in the computer system. A typical 
method to access the BIOS settings screen is to press ESC, F1, F2, F8 or 
F10 during the boot sequence.  

 

boot priority First device, or any device that is higher in the order list having 
preference over devices that are lower in the order. BIOS settings allow 
you to run a boot sequence from a floppy drive, a hard drive or a CD-
ROM drive. You may configure the order that your computer searches 
these physical devices for the boot sequence. For example, to boot from a 
CD-ROM drive instead of a hard drive, place the CD-ROM drive ahead of 
the hard drive in priority.  

 

boot record See MBR. 

 

compressed cluster Data that uses less disk space. When you set a file or folder 
property to compress data, the file or folder uses less disk space. While 
the size of the file is smaller, it must use a whole cluster in order to exist 
on the hard drive. As a result, compressed clusters contain "file slack 
space". This space may contain residual confidential data from the file 
that previously occupied this space. KillDisk can wipe out the residual data 
without touching the existing data.  

 

cluster Logical group of disk sectors, managed by the operating system, for storing 
files. Each cluster is assigned a unique number when it is used. The 
operating system keeps track of clusters in the hard disk's root records or 
MFT records. (See lost cluster)  

 

exclusive access Lock that is applied to a partition for exclusive writing access, for 
example while recovering deleted or damaged files or folders. The recover 
operation must have exclusive access to the target partition while 
recovering files. If another application or the operating system is using 
the target partition, you must close all applications or system processes 
that may be using the target partition before you may lock it. 

 

FAT File Allocation Table. File that contains the records of every other file and 
directory in a FAT-formatted hard disk drive. The operating system needs 
this information to access the files. There are FAT32, FAT16 and FAT 
versions.  

 



free cluster Cluster that is not occupied by a file. This space may contain residual 
confidential data from the file that previously occupied this space.  

 

file slack space Unused portion of a cluster. The smallest file (and even an empty 
folder) takes up an entire cluster. A 10-byte file will take up 2,048 bytes if 
that is the cluster size. This space may contain residual confidential data 
from the file that previously occupied this space.  

 

deleted boot records Damaged or erased MBR. In a damaged disk, if the location 
of the boot records is known, the partition table can be reconstructed.  

 

hive Highest level of organization in the Windows registry. At this level, system and 
local variables are stored. 

 

ISO Informal term for a disk image in the ISO 9660 file standard format. ISO 9660 
file system is a standard, published by the International Organization for 
Standardization. It defines a file system for CD-ROM or DVD-ROM media 
that allows you to read the same CD or DVD whether you're on a PC, 
Mac, or other major computer platform. Making a disk image in the ISO 
9660 file standard (an ISO image) is a common way to electronically store 
and transfer the contents of a hard drive. An ISO image often has the 
filename extension .ISO (although not necessarily), and is commonly 
referred to as an "ISO".  

 

lost cluster Cluster with an assigned number in the file allocation table, even though 
it is not assigned to any file. You can free up disk space by reassigning 
lost clusters. In DOS and Windows, you can find lost clusters with the 
ScanDisk utility.  

 

MBR Master Boot Record. All disks start with a boot sector. When you start the 
computer, the code in the MBR executes before the operating system is 
started. The location of the MBR is always track (cylinder) 0, side (head) 
0, and sector 1. The MBR contains a file system identifier.  

 

MFT records Master File Table. File that contains the records of every other file and 
directory in an NTFS-formatted hard disk drive. The operating system 
needs this information to access the files.  

 

root records See FAT. 

 

SAM Security Account Manager. Database stored as a registry file in Windows. It 
stores users' passwords in a hashed format. Since a hash function is one-
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way, this provides some measure of security for the storage of the 
passwords. 

 

sector Smallest unit that can be accessed on a disk. Sectors are segments within 
each track.  

 

track Circle of data around a disk. Tracks form concentric circles on a disk. 

 

unallocated space Space on a hard disk where no partition exists. A partition may 
have been deleted or damaged or a partition may not have been created.  

 

unused space in MFT records The performance of the computer system depends a 
lot on the performance of the MFT. When you delete files, the MFT entry 
for that file is not deleted, it is marked as deleted. This is called unused 
space in the MFT. If unused space is not removed from the MFT, the size 
of the table could grow to a point where it becomes fragmented, affecting 
the performance of the MFT and possibly the performance of the 
computer. This space may also contain residual confidential data (file 
names, file attributes, resident file data) from the files that previously 
occupied these spaces.   

 

Windows system caching Windows reserves a specified amount of volatile 
memory for file system operations. This is done in RAM because it is the 
quickest way to do these repetitive tasks.  

 

Windows system records The Windows registry keeps track of almost everything 
that happens in windows. This enhances performance of the computer 
when doing repetitive tasks. Over time, these records can take up a lot of 
space. 
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